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Help 

 
 
An information note provides background information. For example, it may explain how changes 
made in one screen affect data that appears in another screen. 
 
 
A caution note explains how to avoid a potential problem, or indicates that a process will cause 
irreversible changes to your data. 
 
 
A tip describes a way to get more from your software. For example, it may explain an alternative way to 
perform a task. 

 

Most Voyager screens have a Help button for quick access to information about using the screen. 
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This chapter provides information on how to effectively use the Yardi Voyager user interface. The 
Voyager Web interface is composed of standard Web-based program elements including menus, 
toolbars, buttons, data screens, and fields. 



 
 

Voyager Online Help 
 

Most Voyager screens have a Help button, which allows you to access information about the screen 
and the procedure, which use it. 

 
 
 

Help button 
 

When you click the Help button, the Help system opens in a separate window. 
 
 

 
To close the Help window, click the X button in the top right corner. 



 
 

Logging in to Voyager 
 
 

In this section: 
 

Using the Internet Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5 
Basic Voyager Screen Elements . . . . . . . . . . . . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6 
Using the Top Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7 

 
 

To log in to Voyager 
 

1   Open a web browser. 
 
2  Type the Voyager Web address (https://yardiaspla5.com/95566cambridge/pages/InvalidLogin.aspx) 

into the Address field of the browser. 

 
 

The Voyager Login screen opens. 
 
 

For help with your login, contact your Yardi Support Team at yardisupport@cresapts.com.  
 

3   Complete the following fields: 
 
 

User Name Type the user name, first letter of your first name followed by your last name.  All lower 
case with no spaces - Example: jdoe 

 
Password Type the password provided by your system administrator. 

 
 

Database Select the LIVE database 
 
 
 

4   Click Submit. A dashboard screen opens. A typical user would see either the Community 
Manager Dashboard or the Leasing Consultant Dashboard. 

 
The dashboard you see is determined by your user settings, which are established by your 
system administrator. 



 
 

The Community Manager Dashboard is shown below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Using the Internet Browser 
 

Voyager always appears in a browser window. The following diagram and table show Microsoft 
Internet Explorer browser features that are pertinent to using Voyager. The same features are 
available in other browsers, but might appear in other places. 

 
Forward button 

 
 

Back button 
File menu 

 
 

Print button 
 
 

File menu Specifies printing options from Page Setup (File > Page Setup) and Print (File > Print) 
dialog boxes. 

 
Back button Displays the previous program screen. 

 
Forward button Displays the program screen ahead of the one you are viewing. This button is active 

only if you have already backed up at least one screen. 
 

Print button Prints the current browser screen. See the File menu for more printing options. 
 
 

A Web-based screen is only a snapshot of the most current program operation. If you perform a 
program task and then click the browser’s Back button, you might go back to an old screen that has 
not been updated. The same warning applies to the Forward button. 



 
 
Basic Voyager Screen Elements 

 
The following diagram and table show some basic Voyager screen elements. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Side menu Provides access to menu selections for performing tasks in Voyager. 
 

Menu Search Used to quickly find a menu item. Enter a word, phrase, or partial word in the search 
box, and 

Voyager immediately returns the matching menu items. 
 

Top menu Provides access to menu selections for performing frequent tasks in Voyager. 
 

Fly Out menu Provides access to specific tasks within a category. 
 

Favorites Displays a list of menu items that you have designated as “favorites.” Select an 
item to open the corresponding screen. 

 
Site Search Used to quickly find Voyager records. 

 
Search Results Displays search results performed in the current session. 

 
History Displays a list of the menu items selected in the current session. Click on an item to 

return to that screen. 

History Favorites Menu Search 
Help 



 
 
Using the Top Menu 

 

The top menu provides access to frequently used tasks in Voyager, as well as links to the home and sys- 
tem home menus. The top menu items can vary depending on what module and dashboard you 
are using, although the Home, Filter, and Log Out links are always available. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

Here are descriptions of some of the common links: 
 
 

Roles Allows you to switch between dashboard views (for example, between the 
Community Manager dashboard and the Affordable Manager dashboard). This 
item only appears if your security settings allow you to view more than one 
dashboard or menu set. 

 
Home Returns you to your module’s home page. For example, if you are in a data screen in the  

Manager module, click this link to return to the Community Manager home page. 
 

Help                            When you click the Help button, the Help system opens in a separate window. 
 

 
Log Out Logs you out of your database. The logged out screen appears. You can log in 

again to the same database or a different one by clicking the link. 



 
 

Side Menu (Main Menu) 
 

Using the side menu, you can access most of the functions in Voyager. The side menu has two (and 
sometimes three) levels. Click on a top-level item to open the second level. Move your cursor 
over a second-level item and a third level opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Top level Second level Third level 
 
 

In this manual, we describe menu selections in this manner: Select (Top Level) > (Second Level) > 
(Third level). For example: Select Residents > Move-In Functions > Move In. 

 
 

Menu Search 
 

The menu search feature allows you to quickly find a menu item. Enter a word, phrase, or partial 
word in the search box, and Voyager immediately returns the matching menu items. 

 
 
 

Menu Search 
 
 
 
 
 
 
 
 
 

In the example above, we entered the word “straight” and Voyager returned all the menu items related 
to straight-lining. 



 
 

When you click the desired menu item, Voyager opens the corresponding screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Favorites 
 

When you click the Favorites icon, Voyager displays a list of menu items that you have designated as 
“favorites.” Select an item to open the corresponding screen. 

 
Favorites icon 

 
 
 
 
 

Favorites menu 
 
 
 

Adding and Deleting Items on the Favorites Menu 
 

To add an item to the Favorites menu, locate it on the side menu, and right-click. The Add to 
Favorites box appears. Select it. 

 

 
 

Right-click and select Add to Favorites 
 
 
 

To delete an item from the Favorites menu, right-click it and select Delete. 
 
 
 
 
 
 

Right-click and select Delete 
 
 
 

The Favorites menu is linked to the user and the current menu set. Each user can build and maintain a 
favorites menu for each Voyager module he/she uses. 



 
 
 

History 
 

When you click the History icon, Voyager displays a list of the menu items selected in the current ses- 
sion. Click on an item to return to that screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The History feature only tracks items selected from the menu, not links from the dashboard. This is by 
design. 

 
 
 

Filter Screens 
 

Filter screens enable you to find existing data records. For example, if you are looking for a 
resident record, you select Resident > Find Resident, and a filter screen appears. 



 
 
 
 

In the filter, you enter search criteria. When you click Submit, Voyager displays a list of residents that 
match your criteria (the search results) and the first record in the list. 

 
First record in the list Search results 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Many filters have no required fields. In some cases, it makes sense to leave a filter blank and click 
Submit. The system displays all the records of that type on the left, and you can select which 
records you want to see. 

 

Other filter screens are used for functions. For example, if you select Resident > Resident Rent 
Increase, a filter appears where you specify details of the rent increase. 

 
The following is an example of a filter screen and some of its features: 

 
Mandatory field 

 
 
 
 
 
 
 
 

Pop-up link 
 
 
 
 

Date field 
 
 

Drop-down list 
 
 
 
 
 

Drop-down list Displays a list of options to choose from. You can only choose one item from the list 
at a time. 

 
Pop-up link Opens a look-up list to search for codes that you want to review. 

 
Mandatory field Fields highlighted in blue are required and must be completed before you can 
proceed. 

 
Date field Click the calendar icon to choose a specific date to complete the Date field. 



 
 
 

Filter Search Results 
 

When you use a filter to search, the results appear in a box in the main screen (they no longer appear 
on the side menu). 

 
Filter Search Results box Search Results icon 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can minimize the results by clicking the Search Results Icon. The box disappears. The search 
results persist, and you can bring them back by clicking the icon again. 

 
 

Multiple Searches 
 

If you search for another item, the search results box retains the original search results and displays a 
new tab for the second search. 

 
Tab for old 
results 

Tab for new results 



 
 

A third search will result in a third tab, and so on. 
 
 
 
 
 
 
 
 
 
 
 

To close a tab, click the “X” to the right of the name. 
 
 

Refresh Button in Search Results 
 

The Search Results box contains a Refresh button that will rerun the original search. 
 
 
 
 

Refresh button 
 
 
 
 
 
 

In the example shown above, we searched for the “1101” unit record. There were no results, 
because the record had been given the wrong code. We then located the record and changed the 
code. 

 
 
 
 
 
 

Search results after refresh 
 
 
 

Later on, we wanted to access the record. Instead of repeating the search, we just clicked the Refresh 
button in the Search Results box, and the record appeared on the screen. 



 
 

Using Look-up Lists (Pop-up Links) 
 

The pop-up link opens a new window that displays the codes you need to complete a particular field. 
 
 

Search field 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you do not immediately know the codes you need, type the first characters of the codes or the 
descriptions in the Search field. Click Find to display the results of your search. When you find the 
codes of your choice, select the codes you want and click OK. The field on the filter screen is 
completed with the codes you selected. 

 
For efficiency, you can search for codes using a wildcard search. A wildcard allows you to use a symbol, 
in this case the percentage sign (%), as a substitute for certain characters in a code. Here are a 
couple of ways to demonstrate the wildcard search, using the Property pop-up list as an example: 

 

!    pa 
 

If you are looking for all properties that begin with the letters pa, include the percentage sign after 
pa. Click Find and the pop-up list displays those properties for that search. 

 
!    palm 

 
If you are looking for all properties that contain the word palm, enclose the word in percentage signs. 
Click Find and the pop-up list displays those properties for that search. 

 
When you type the code of your choice, you will find a description of that code to the right of the field 
on the filter screen. This description will help you identify the code that you are using. The 
following is an example of a property code description. 

 
Code description 



 
 

Using the Drop-down List 
 

The drop-down list provides a list of options to choose from. When you click the down arrow, the list of 
options appears. The following is an example of the Status drop-down list: 

 
 
 
 

Drop-down list 
 
 
 
Using the Date Fields 

 
If you need to complete a Date field, the calendar icon comes in handy. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Calendar 
icon 

 
 
 
 
 
 
 

When you click the calendar icon, a calendar opens showing the current month and year. The 
current date is highlighted. 

 
 
 
 
 
 

Current date 
 
 
 

You can search through the months and years to find the date you need. Single arrows (< , >) move 
the calendar one month forward or back. When you locate the appropriate date, click it to select it. The 
calendar closes and the date field is filled in. 



 
 

Understanding Data Screens 
 
 

In this section: 
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Data screens store property management information, ranging from prospect, applicant, and 
resident records to transaction records. Data screens are set up with the record navigation list on the 
left side of the screen and the first record in the list displaying on the right side of the screen. You can 
choose the records you want to review or update by finding the records through the navigation list 
on the left. The following is an example of the Resident screen: 

 
Functions menu Jump To 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Command 
buttons 

Search box 

 
 

Functions menu Provides links to common functions that apply to the record type. 
 

Jump To Finds another record of the same type. 
 

Command buttons The basic buttons used throughout data screens: New, Save, Delete, Cancel, and Help. 
 

Search box Shows all or chosen records for the screen that you are on. 



 
 

Using the Jump To field 
 

The Jump To field is located on the upper right hand corner of the screen. If you need to find another 
record of the same type, the Jump To field can locate the record quickly. From any data screen, 
type the code you want to view and press the TAB key on your keyboard. The record displays on 
the right side of the screen. You can only view one record at a time. 

 
Using the Search Box 

 
By default, the Search box appears on the right side of the screen. This box shows the available or 
chosen items for that data screen. Use the scroll bar and navigation buttons to browse through all 
the items on the Search box. 

 

Click an item in the Search box to select it. It is displayed to the left of the Search box. 
 
 

Using the Functions Menu 
 

The Functions menu appears on many of the data screens and provides links to common 
functions that apply to the record type. The specific functions that appear are related to the status of 
the record. For example, if a resident’s status is future, the Move In function appears on the menu. 
For a current resident, the Notice function appears. 

 
Using the Command Buttons 

 
The Command buttons provide the common functions to proceed in a screen. Examples are New, 
Save, Delete,  Cancel,  and Help. 



 
 

Automatic Field Formatting 
 

Throughout Voyager, there are several formatting conventions that the program applies to data you 
type on the screen. For your convenience, Voyager converts the information appropriately. 

 
 

Date For date fields, you do not need to type a forward slash (/) or dash (-) to complete the 
date. Use the following formats as they apply to the date field: mmddyy, mmddyyyy, 
mmyy, or mmyyyy. 

 
Dollar sign For any fields that require dollar amounts, you do not need to type a dollar sign ($). 

 
Email                           For any fields where you can include an email address, the program creates an active 

link so that you can send an email message if necessary. This does not apply to the 
Reports menu. Type the email address in its entirety, and the program makes the 
link active (underlined, blue). 

 
Percent sign (%) For any fields that require a percentage amount, you do not need to type a percent 
sign (%). 

 
Telephone number For any fields that require a telephone number, you do not need to include 

parentheses () around the area code or a dash (-) between digits. 
 

Time For any fields where you need to type the time, you do not need to include the 
colon (:). The program formats the time appropriately. However, you do need to 
type “AM” or “PM” after the numbers, for example, “900 AM.” 

 
 
 

Site Search 
 

The Site Search feature allows you to quickly find Voyager records. 
 

 
Site Search 

 
 
 
 
 

You can search all records, or you can narrow your search to single record type. 
 
 

Using a Search Code 
 

In the following example, we were looking for a vendor record that started with “lum.” We entered 
the search code for vendors, “V,” followed by a colon and “lum.” 

 
Search string 

 
 

Search results 
 
 
 
 
 
 
 
 

The search returned only vendor records. 



 
 

Searching Without a Search Code 
 

If you search without a search code, Voyager looks at all the records in the database. In the 
following example, we entered “que” and Voyager returned all the matching records: properties, 
property lists, leases, and owners. 

 
Search string 

 
 

Search results 
 
 
 
 
 
 
 
 
 

Each record type appears in a separate tab. 
 
 

Search Codes and Columns Searched 
 

The following table gives the search codes for each record type. It also lists the database fields that 
are searched for each record type. 

 

Record Type 
 

Search Code Table Columns Searched 
 

Job 
 

Job 
 

Code, Description, Site Address, Site City, Site ZIP 

Mortgage AP Mort Code, Description 

Commercial Deal CommDeal Code, Description 
 

Memo 
 

Memo 
 

Description 

Bank Bank Code, Description 

Tenant Resident Code, Last Name, Address 1, Address 2, City, State, ZIP 
Code 
 

 

Owner 
 

O 
 

Code, Last Name, Reg. No 

DCF Analysis Dcf Code, Description 

Unit U Code 

Charge type ChargeType Code, Description 

Contract Contract Code, Description 

Vendor V Code, Description 

Account Acct Code, Description 

Property P Code, Address 1, Address 2, Address 3, City, State, ZIP 
Code 

  



 

Record Type Search Code Table Columns Searched 

Fund_data Fund Code, Name 

Customer Customer Code, Name 

Contact Contact Code, Description, Company Name, Last Name, First 
Name, Email, Address 1, Address 2, City, ZIP Code 

 

 

Hot Keys 
 

You can now create keyboard combinations for menu items. For example, if you frequently need to 
review customer records, you could create a keyboard combination for the Review Customer screen. 

 

 
To add a hotkey 

 

1   Select the menu path (for example, Lease Administration  > Customers > Review Customers). 
 

2   Right-click the last item in the path. A box appears below the menu item. 
 
 
 
 

Add Hotkey 
 
 

3   Select Add Hotkey.  A window appears. 
 
 
 
 
 
 
 
 
 
 

4   Add a keyboard combination by holding down the ALT key and typing a letter. 
 

5   Click the Assign Hot Key button. 
 

If there is a conflict with an existing keyboard combination, an error message will appear, and you 
can select another combination. 

 

Once the hot key has been created, you can use it instead of selecting the menu item. 
 
 

Default Hot Keys 
 

Two global keyboard combinations are included as defaults: 
 
 

Alt+R Closes the Search Results window (or re-opens it, if it is already closed). 
 

Alt+M Collapses the side menu (or expands it, if it is already collapsed). 
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LIHTC Guest Card Workflow 
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This lesson explains how to add guest cards for LIHTC prospects. 
 
 

Introduction to LIHTC Guest Card Workflow 
 
Prospect guest cards document prospects who are actively seeking rental housing. A guest card keeps all 

information for a prospective household in a single location and simplifies application processing. 
 

The leasing and qualification process begins when you add the prospect’s guest card. Although you use 
the same initial leasing steps for all households, you must qualify a household for LIHTC housing before 
the household moves in. 
 

This lesson describes how to begin the leasing process for a new LIHTC prospect. In this lesson, you will 
learn how to complete the following tasks: 
 

• Add a guest card for an LIHTC household. 
 

• Add additional adult family members as occupants. 
 
You will also learn how to find prospects and record contacts with the prospects. 
 
 
 
 
 
 
 



 

 
 
The following chart shows the leasing workflow for LIHTC housing applicants. The Guest Card, Prefer-
ences, and Occupants leasing steps are the subject of this lesson. 
 
 
 

 



 
 
 
Adding Guests as Quick Guests 
 
When a prospect contacts you, you can add the prospect as a “quick guest” to document needed infor-
mation about the prospect and the household’s needs. Using the Quick Guest screen to add a guest 
card is especially convenient if the prospect or you are pressed for time or if the prospect does not 
want to immediately apply. The Quick Guest screen includes a list of available units that you can 
review with a prospect while you are adding information. If you showed a unit to the prospect during 
the initial contact, you can document the showing. 
 
Saving quick guest information adds a guest card for the prospect and includes the prospect in the 
property’s prospect pipeline. After saving, you can either immediately continue with the leasing work-
flow or you can close the Quick Guest screen and continue later. 
 
 

To add a prospect as a “quick guest” 
 
1 On the Community Manager Dashboard screen, type or select a property code. 
 
2 Click Quick Guest. The Quick Guest screen appears. The property or property list selected on the 

dashboard appears in the top part of the screen, on the right. The date defaults to your system date. 
 
 
 

Property and date 



 
 
 

3 Complete as much of the following information as the prospect provides. The shaded fields are 
required. 

 
 
 

First Name 
 

Last Name 
 

Address 
 

City State Zip 
 

Tel # Office-Home 
 
 
 

EMail 
 

Notes 
 
 
 

Date 
 

First Contact 
 

Agent 
 

Source 
 

Result 
 
 

Expected Move-In 
 

Bedrooms 
 

Desired Rent 

Type the prospect’s first name. 
 
Type the prospect’s last name. 
 
Type the prospect’s street address. 
 
Type the city or town in which the prospect lives, type or select the state, and type the ZIP code. 
 
In the first field, type the prospect’s telephone number at work, including the area code. 
 

In the second field, type the prospect’s home telephone number. 
 
Type the prospect’s e-mail address. 
 
If needed, type remarks or notes. 
 

NOTE Ensure that any notes or remarks comply with fair housing laws. 
 
The system date on your workstation appears. If needed, change ghe date. 
 
Select the way that the prospect contacted you. 
 
Select the leasing agent who is working with this prospect. 
 
Select the way that the prospect heard about your property. 
 
If this contact produced a result, such as a future appointment or other result, type or select the 
result. 
 
Type the date that the prospect wants to move in. 
 
Type the number of bedrooms that the prospect needs. 
 
For affordable housing prospects, leave this field empty. 
 

NOTE For market-rent prospects, this field identifies the prospect’s desired rent payment. 
Because affordable housing programs determine rent based on income or income limits, this 
field does not apply to affordable prospects. 

 
 

4 Review available units if needed. 
 

The codes for units and unit types on the Quick Guest screen are links. You can click these links to 
review the characteristics of the available units. The Occupancy column shows the status of each 
unit. For units with a status of Notice, the occupancy status is a link to the Resident screen for the 
resident on notice. 



 
 

5 Click Save. You have added a prospect to the Voyager Prospect Pipeline. The Occupants section 
appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Occupants 
 

Add New Occupant 
 
 
 
 
 
 
 

Go to Leasing Workflow 
 
 
 
 
 

You can now add additional household members as occupants, begin the leasing workflow, or click 
the Homebutton in the top part of the screen to close the Prospect Guest Card screen and continue 
later. 

 
 

To add a household member as an occupant 
 
1 Click the Add New Occupant link. The Occupant screen appears. 
 
2 Complete the following information for the occupant: 
 
 

First Name 
 

MI 
 

Last Name 
 

Relationship 

Type the household member’s first name. 
 
Type the first letter of the member’s middle name. 
 
Type the household member’s first name. 
 
Select the occupant’s relationship to the household head. 
 

! If the person is a spouse, select Spouse. 
 

! For all persons other than a spouse, select Other. 



 
 
 
 

Lessee 
 
 
 
 
 

DOB 
 

Social Security 

This check box is selected by default. 
 

! If this person is an adult family member, do not deselect the check box. HUD requires all 
adult family members to be on the lease. 

 

! If the member is a dependent, deselect the check box. 
 
Type the member’s date of birth. 
 
Type the household member’s Social Security number. 
 

NOTE When you begin the affordable housing qualification process, you will complete 
member information for each household member. The date of birth and Social Security 
number that you record on the Occupant screen will appear on theMember screen for this 
occupant. 

 
 

3 Add other information as needed by your management organization. 
 

The following graphic shows the Occupant screen completed for a dependent family member. 
 
 
 
 
 
 
 

Relationship 
 

Lessee check box 



 
 
 

4 Click Save. The Occupant screen closes. The Occupants section now shows the occupant. 
 

The following graphic shows the Quick Guest screen. The name and Social Security number of the 
dependent shown in the previous graphic appears in the Occupants section of the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Occupant 
 
 
   
 
 
 

 

 Begin the leasing workflow 
 
 
 
5 When you are finished adding information for this household, click the Home button close the 

Quick Guest screen. 
 

If the quick guest is ready to provide more information or to apply as a resident, you can 
click the Go to Leasing Workflow link in the bottom part of the screen and begin the leas-
ing workflow process.. 



 
 
 

Adding Guest Cards for LIHTC Prospects 
 
Adding a guest card automatically adds the household to the Prospect Pipeline on the Community 
Manager Dashboard. The name on the guest card becomes the name of the household head for cer-
tification purposes and the name on the Resident screen for the household after move-in. 
 
 

To add a guest card for an LIHTC prospect 
 
1 In the Prop/List field on the Community Manager Dashboard, select a property and then press 

the TAB key. The Community Manager Dashboard displays the information for the selected prop-
erty. 

 
2 Click the Add Guest link. 
 

Selected property 
Add Guest link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TheProspect GuestCard screen appears. The Leasing Steps menu appears on the right. Guest Card 
is the selected leasing step. 

 
Guest Card leasing step 



 
 
 

3 Complete the information for the household head: 
 
 

First Name 
 

MI 
 

Last Name 
 

Address 
 
 
 
 
 

City State Zip 
 
 

Tel # Office-Home 
 
 
 
 
 
 
 
 

DOB-DL# / State 
 
 
 
 
 
 
 

Email 
 

Notes 
 

First Contact 
 

Agent 
 

Source 
 

Date 

Type the first name of the household head. 
 
Type the first letter of the member’s middle name. 
 
Type the last name of the household head. 
 
On the first line, type name of the property in which the prospect lives; for example: Oldtown 
Apartments. Or, type the street address; for example: 1 Previous Street Unit 1B. 
 

If you typed the property name on the first line, type the street address and unit number on the 
second line. 
 
Type the name of the city. Press the TAB key on your computer. Type or select the two-character 
state code; for example, SC. Press TAB and type the ZIP code. 
 
In the field on the left, type the phone number where the prospect can be contacted at work. 
Include the area code. Type the phone number without formatting; for example: 8432345678. 
Voyager will format the number for you. 
 

Press the TAB key. In the field on the right, type the phone number where the prospect can be 
contacted at home. 
 

Press the TAB key. If the prospect has a cell phone or FAX number, type those numbers in the 
same way. 
 
You may record the date of birth now or later during the qualification process. If you record the 
date of birth now, Voyager will include it in the member’s information for qualification 
purposes. To record it now, type the date without formatting; for example: 090876. Press the 
TAB key. Voyager formats the date; for example: 09/08/1976. 
 

If needed, you can also add prospect’s drivers’ license information. In the field on the right, type 
the driver’s license number and select the licensing state. 
 
Type the email address of the household head. 
 
Type notes or remarks, if needed. 
 
Select the way that the prospect head contacted you. 
 
Select the leasing agent who is working with the prospect. 
 
Select eh way that the prospect learned about the property. 
 
This date is the day that the prospect initially contacted you. the system date on your 
workstation appears. Change the date if needed. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Click the Next button to advance to the Preferences leasing step. The Preferences tab appears in 
the bottom part of the screen. 

 
If a waiting list is set up in this property in Voyager, the Waiting List button appears. You can now add the prospect 
to the waiting list. This guide explains how to add prospects to Voyager Affordable Housing waiting lists in “LIHTC 
Property Waiting Lists” on page 97. 

 
 

5 Type the household’s expected move-in date and the number of bedrooms needed. 
 

Preferences leasing step 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Preferences tab 



 
 
 

6 Click Next to advance to the Occupants leasing step. The Occupants tab appears in the bottom 
part of the screen. 

 
Occupants leasing step 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Occupants tab 
 
 

You have now added enough information to the household’s guest card for Voyager to save the guest 
card. If needed, you could click the Home button in the top part of the screen and continue later. We 
will continue with the Occupants leasing step. 

 
Home button 

 
 
 
 
 
 
 
 
 

When you qualify an affordable housing household, your first step is to complete the Member screen 
for each household member. Voyager partially completes the Member screen for the household 
head. Voyager also automatically completes the name, date of birth, and Social Security number on 
the Member screen for members added as occupants. You will add more details when you complete 
the qualification steps. 

 
Voyager adds member information for occupants only if you add the occupants now, the first time that you use the 
Occupants leasing step. If you return to the Occupants step from other leasing steps and add information for 
additional occupants, Voyager will not complete theMember screen for those additional occupants. 

 
 

Adding a household member as a unit occupant also adds the person to the Roommates section of 
the Resident screen. When the household becomes a resident household, you will be able to search 
your Voyager database to find the household member. You may want to add the spouse, co-head, or 
all adult members of the household as occupants 



 
 
 

To add a household member as an occupant 
 
1 On the Occupants tab, click the Add New Occupant link. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add New Occupant 
 
 

The Occupant screen appears. 



 
 
 

2 Complete the following information for the occupant: 
 
 

First Name 
 

MI 
 

Last Name 
 
 

Relationship 
 
 

Lessee 
 
 

DOB 
 

Social Security # 

Type the household member’s first name. 
 
Type the first letter of the member’s middle name. 
 
In the field on the left, type the household member’s last name. In the field on the right, select 
the prefix that applies. 
 
Select the occupant’s relationship to the household head. If the person is a spouse, select 
Spouse. For all persons other than a spouse, select Other. 
 
If this person is an adult family member, select this check box. HUD requires all adult family 
members to be responsible for the lease. 
 
Type the member’s date of birth 
 
Type the member’s Social Security number. 

 
 

3 Add other information as needed by your management organization. 
 

The following graphic shows the Occupant screen completed for an adult family member. 
 
 
 
 
 
 
 
 

Lessee check box 
 
 
 
 
 
 
 
 
 
 
4 Click Save. The Occupant screen closes. The Occupants tab now shows name of the occupant. 
 

You may be tracking many prospects at any one time and need ways to remember details about each 
prospect. Documenting contact events helps you to remember these details. 

 

When you add a prospect’s guest card, Voyager automatically adds a first-contact event to the guest 
card. The description automatically shows the words First contact. You can add notes and other 
information. You can also document additional contact events so that you can document all 
communication with the prospect. 



 
 
 

To document a contact event for a prospect 
 
1 Open the guest card for the prospect. 
 
2 Click the Contacts button. The Contacts tab appears in the bottom part of the screen. 
 

Contacts button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Default contact description Edit contact informaton 
 
3 Click the Add New Contact link. A screen appears labeled Contact for followed by the prospect’s 

name. 



 
 
 

4 Add the following information: 
 
 

Type Select the type of contact event. 
 

Agent Select the agent who is working with this prospect. 
 

Date The system date on your workstation appears. If you are recording notes for a contact event 
that you made on another day, type the date of the event. If you are documenting an 
appointment, type the date of the appointment. 

 
 

5 Add the following information: 
 
 

Result Select the result of the contact, if needed. 
 

Time Type the time, or click the Clock button and select the time that the prospect made the 
contact or the time of the scheduled appointment. 

 
Unit If this contact is about a specific unit, type the unit code or select the unit. 

 
 

6 In the Notes field, type your remarks. 
 

The following graphic shows the Contact screen completed for a scheduled appointment. The notes 
document the purpose of the appointment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7 Click Save. The Contact for screen closes. 
 
 

When you save a contact for an appointment, the appointment appears on the Calendar tab of the Community 
Manager Dashboard screen for the user adding the appointment. The appointment will also appear in the Daily 
Activity report. 



 
 
 

8 Click Next to advance to the Select Unit step. 
 

TheSelect Unit screen appears. If the property is set up so that LIHTC residents are the default tenant 
type, the Tax Credit check box is automatically selected. No available units appear for selection. You 
will select a unit after qualifying the household. You are ready to begin the qualification process. 

 
 

Select Unit leasing step 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Unit tab 
 
 

If the property contains a mix of market-rent and LIHTC residents, and if LIHTC residents are not the default tenant 
type, a list of available units appears on the Select Unit tab. Although you can select a unit before qualifying the 
household, selecting a unit after you complete the qualification process ensures that the resident qualifies for the 
unit. When the qualification process is complete and the household qualifies, the Select Unit tab appears again 
showing only available units for which the household qualifies. 

 

If the property is set up to allow only one applicant per unit, a selected unit becomes unavailable for other 
households. If you select a unit and then discover that the household is unqualified, you may miss the opportunity 
to assign the unit to a qualified household. 

 
 

9 If the Tax Credit check box is not selected, select this check box. Available units no longer appear 
on this tab. 

 

You are ready to begin the qualification process for this guest. You will now learn how to use the 
Community Manager Dashboard screen to find the prospect for whom you have just recorded a 
contact event. 

 
10Click the Home button in the top part of the Community Manager Dashboard screen. 
 
 

To learn how begin the qualification process for a prospect whom you have added as a guest, see Chapter 2, “LIHTC 
Household Member Documentation.” 



 
 
 

Selecting Prospects from the Prospect Pipeline 
 
Use the Prospect Pipeline on the Community Manager Dashboard screen to review the active pros-
pects for a selected property or property list. Active prospects are households for which you have doc-
umented activity within the last thirty days. Each time that you add a guest card for a prospect, the 
Prospect Pipeline total increases by one. 
 
 

To select a guest on the Prospect Pipeline 
 
1 On the Community Manager Dashboard screen, select a property and then press the TAB key. The 

Community Manager Dashboard screen displays the information for the selected property. 
 

2 In the Traffic section of the dashboard, click the number to the right of Prospect Pipeline. The 
Prospect Pipeline tab appears in the bottom part of the screen, displaying a list of the active pros-
pects. The prospect names are links to their guest cards. 

 
Link to Prospect Pipeline Selected property 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Links to guest cards 
 
 

3 Click the name of the prospect with whom you want to work. The Prospect Guest Card screen 
appears. 

 
" If you are ready to qualify the prospect, or if you are in the process of qualifying the prospect, 

Select Unit is the selected leasing step. 
 

" If you are in the process of adding the person’s guest card and have not yet begun the qualifica-
tion process, the selected leasing step is the step that you were completing when you stopped 
working. 



 
 
 

Finding Specific Prospects and Residents 
 
You can use a person search to find any prospect in your database, whether or not the prospect is an 
active prospect. You can also use person searches to find residents and persons added when you com-
pleted the Occupants leasing step. You can search by name, code, phone number, social security num-
ber, e-mail address, or driver’s license. 
 
In this lesson, you will search for a person by the person’s last name. 
 
 

To search for a specific guest by last name 
 
1 On the Community Manager Dashboard screen, click the Person Search tab. The Person Search 

tab appears in the bottom part of the dashboard. 
 

2 In the Name field, the person’s last name. 
 

If you do not remember a person’s entire last name, you can type a few letters of the name. Voyager 
will find all people with letters that match. For example, if you were searching for Lilly Li, you might 
type Lilly, Li, or li. 

 
Voyager will find all people whose names contain the letters that you type. The letters 
could be at the beginning, middle, or ending of a name. Person search is not case sensitive. 

 
 

Name field 
 
 
 
 
 
 
 
 
 
 

3 Click Search. A list of people matching your selection criteria appears. Names of prospects are links 
to the Prospect Guest Card screen. If the list includes residents, resident names are links to the 
Resident screen. 

Lilly Lii



 
 

4 Click the name of the prospect with whom you want to work. 
 

The Prospect Guest Card screen appears. The selected step on the Leasing Steps menu is the last 
step that you completed for the prospect. 
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LIHTC Household Member Documentation 
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This lesson explains how to record member information needed for qualifying LIHTC households. 
 
 

Voyager Affordable Housing also includes HUD project-based, Rural Development Section 515, and the HOME 
Investment Partnership housing programs. Voyager configures the Member screen based on the housing programs 
under which a property operates. If a property operates under more than one housing program, the screen examples 
and information described in this lesson will vary from the Voyager screens that you see. 

 
 
 

Introduction to LIHTC Member Documentation 
 
Affordable housing qualification begins by documenting personal information about each member of 
the household. You will record information for each person living in the unit with the household, 
whether or not the person is considered to be a family member. 
 

In this lesson, you will learn how to complete the following tasks: 
 

• Record information for the household head. 
 

• Record information for people whom you added through the Occupants guest card leasing step. 
 

• Record member information for all additional household members. 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
The following chart shows the leasing workflow for LIHTC housing applicants. The Member qualifica-
tion step is the subject of this lesson. 

.  



 
 
 

Documenting LIHTC Household Heads 
 
When you add a guest card for an affordable housing prospect, Voyager automatically creates a mem-
ber record for that person and assigns the person’s family status as household head. The Member 
screen is only partially completed. You must open the screen and add the additional information 
needed for the household’s certification. 
 
In this lesson, you have added a guest card for a prospective LIHTC household and are ready to begin the 
affordable housing qualification process. The name on the guest card is that of the household head. 
 
Your first steps are to complete the member information for the household head and for those members 
whom you added when you completed the Occupants leasing step. 
 
 

To complete the member information for a household head 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. 
 

The Qualification Steps menu appears in the top part of the screen, on the right. The Family 
Members leasing step is selected. The Family Members tab appears in the bottom part of the 
screen, showing the name of the household head and the name of each person added as an 
occupant. 

 
Family Members 

 
 
 
 
 
 
 
 
 

Family 
Members tab 

 
 
 
 

Household head Member added on the Occupants leasing step 



 
 
 

3 Click the Edit link on the row displaying the name of the household head. 
 

TheMember screen appears. The Relationship field displays the wordHead. The person’s name and 
date of birth are automatically completed. 

 
The following graphic shows an example of the Member screen as it appears for a household head 
the first time that you open it. Only the name and date of birth appear. 

 
 
 
 

Relationship 



 
 
 

4 Complete the following information the Family Member Data section: 
 
 

Relationship 
 
 

Ethnicity 
 
 
 
 
 

Sex 
 

Birth Date - Age 
 
 
 

SSN 
 

Alien Registration 
 
 

F/T Student 
 

Disability Status 
 
 
 
 
 

Race (Choose all that apply 

For a household head, Voyager automatically selects Head. You cannot change this 
information for a household head. 
 
Select the ethnic background that best represents this household head. 
 

Options for ethnicity include Declined toReport. If you are not required to select a specific 
ethnicity and the household head does not want to specify an ethnicity, selectDeclined to 
Report. 
 
Select the gender of the household head. 
 
Type the date of birth of the household head, and then press the TAB key. The Age field 
automatically displays the person’s age as of the estimated effective date of the move-in 
certification. 
 
Type the Social Security number of the household head. 
 
If the household head is not a citizen of the United States, type the person’s alien 
registration identification number. 
 
If the household head is a full-time student, select this check box. 
 
If the household head is disabled, select Disabled. If not, leave this field empty. 
 

If Declined to Report appears as an option, the member does not want to declare a 
disability status, and the housing program for which the member is qualifying allows this 
option, you would select Declined to Report. 
 
Select the race of the household head. You can select more than one race. 
 

Options for race include Declined toReport. If you are not required to select a race and the 
person does not want to specify a race, select Declined to Report. 

 
 

5 Complete the following information in the Tax Credit Data section: 
 
 

Occupation 
 

Marital Status 
 

PSR Special Status 

Type a brief description of the person’s job. 
 
If this field appears on the screen, select the person’s marriage status. 
 
If the person is elderly or disabled, select the status that applies for your state’s project status 
report 
 

NOTE PSR (project state report) is the term in Voyager for the report that a state periodically 
requires to monitor the performance of housing projects and determine compliance with 
housing program rules. Although most states require this report annually, some states require 
the report more frequently. 

 
 

6 If your state agency uses the NAHMA-XML standard for tax credit state reports, make the most 
appropriate selection in each of the following NAHMA fields: 

 
 

Relationship Type 
 

Employment Type 

Select the relationship type that identifies this person as household head. 
 
Select the person’s type of employment. 



 
 
 

7 Select a letter for verifying the member’s information. 
 

Letter button Correspondent button Add Correspondent button 
 
 
 
 
 
 
 
 
 
 
 

a Click the Letter button located to the right of the first Letter field. A selection list of letters 
appears. 

 

b Select a letter and click OK. The selection list closes. The code of the selected letter appears in the 
Letter field. 

 
8 Add correspondent information for the person or organization that will receive your letter. 
 
a Click the Add Correspondent button. The Correspondent screen appears. 

 
b Complete the information for the correspondent, click Save, and then close the Correspondent 

screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can now select this correspondent for the letter. 



 
 
 

9 Select the correspondent that you just added. 
 
a Click the Correspondent button to the right of the first Send To field. A selection list of corre-

spondents appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b Select the correspondent and then click OK. The selection list closes. The code of the selected cor-
respondent appears in the Send To field. 

 
Date Sent and Response Date fields appear on each row so that you can type the date that you sent the letter 
and received a response. If you are printing verification letters in Voyager, leave these fields empty. Record the 
sent and received dates later in the Verification step after you print the letters. You can concurrently record 
these dates for all selected member, income, asset, and expense verification letters. 



 
 
 

The following graphic shows an example of the Member screen completed for a disabled household 
head. 

 
 
 
 
 
 
 
 
 

Disabled 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selected letter and correspondent 
 
 

10Click Save. The Member screen closes and the Family Members tab appears. 



 
 
 
 

Documenting LIHTC Household Members Added as Occupants 
 
When you use the Occupants guest-card leasing step to add a household member, Voyager partially 
completes the Member screen for that person. You must add the additional information needed for 
the certification. 
 
 

To complete member information for a person added to a household’s guest card as an occupant 
 
1 On the Family Members tab, click the Edit link on the row displaying the name of the household 

member. The Member screen appears. 
 
2 Add the following information in the Family Member Data section: 
 
 

Relationship 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

First Name 
 
 

Middle Initial 
 
 

Last Name 

Select this person’s relationship to the household head. Options are: 
 

Spouse This person is the marriage partner of the household head. If you select Spouse, you 
cannot define another member as co-head. There can be a spouse or co-head, but not both. If 
there is a spouse, designate that person as the spouse on each recertification. 
 

CoHead This person is the co-head of the household but not the spouse of the household 
head. If you select CoHead, you cannot define another member as spouse. There can be a 
spouse or co-head, but not both. If there is a co-head, designate that person as co-head on 
each recertification. 
 

Dependent This person is age 17 or younger, 18 or older and disabled or a full-time student, 
a child temporarily absent due to placement in a foster home, a child who is subject to a joint-
custody agreement (lives in the unit at least 50% of time), a full-time student (regardless of 
age) who is away at school but who lives with the household during school breaks, or a child 
being adopted (or custody being sought) and currently living in the unit. 
 

Other This person is an adult member of the household who is not the head, spouse, co-head, 
foster child, or foster adult. This person has income that you are including when determining 
the household annual income. You cannot use this member's status to justify the eligibility of 
the household for elderly or medical allowances. 
 

Foster This person is a foster child under the age of 18, the child of a foster child, or a foster 
adult. 
 

Live-in This person lives in the unit but is not a member of the household. Include foster 
adults, live-in attendants, and children of live-in attendants. Review the regulatory definitions 
of these terms. People in this category do not have rights under the lease. People in this 
category are not considered members of the household and you should not count their 
incomes in determining the household's annual income. 
 

Unborn Child This person is the unborn child of an expectant mother who is a family member. 
 

None of the Above The relationship of this person to the household is other than a 
relationship included on this list. 
 
The first name that you typed on the Occupant screen appears. If needed, you can change the 
name. 
 
The letter that you typed as the middle initial in the Occupant screen appears. If needed, you 
can add or change the initial. 
 
The last name that you typed on the Occupant screen appears. If needed, you can change the 
name. 



 
 
 
 

Ethnicity 
 
 
 
 

Sex 
 

Birth Date - Age 
 
 

SSN 
 

Alien Registration 
 
 

F/T Student 
 
 
 
 

Disability Status 
 
 
 
 
 

Race 

Select the ethnic background that best represents this household member. 
 

Options for ethnicity include Declined to Report. If you are not required to select a specific 
ethnicity and the member does not want to specify an ethnicity, select Declined to Report. 
 
Select the person’s gender. 
 
Type the person’s date of birth and then press the TAB key. The Age field automatically displays 
the person’s age. 
 

Type the person’s Social Security number. 
 
If the household member is not a citizen of the United States, type the person’s alien 
registration identification number. 
 
Complete this check box as follows: 
 

If this person is a full-time student as of the effective date of this certification and a full-time 
student, select this check box. 
 
If this person is a disabled spouse, co-head of household, or dependent, select Disabled. 
 

If the member is not disabled, you can leave this field empty. IfDeclined to Report appears as 
an option, the member does not want to declare a disability status, and the housing program 
for which the member is qualifying allows this option, select Declined to Report. 
 
Select the race of this person. You can select more than one race. 
 

Options for race include Declined to Report. If you are not required to select a race and the 
person does not want to specify a race, select Declined to Report. 

 
 

3 Complete the following information in the Tax Credit Data section: 
 
 

Occupation 
 

Marital Status 
 

PSR Special Status 

Type a brief description of the person’s job. 
 
If this field appears on the screen, select the person’s marriage status. 
 
If the person is elderly or disabled, select the status that applies for your state’s project status 
report 
 

NOTE PSR (project state report) is the term in Voyager for the report that a state periodically 
requires to monitor the performance of housing projects and determine compliance with 
housing program rules. Although most states require this report annually, some states require 
the report more frequently. 

 
 

4 If your state agency uses the NAHMA-XML standard for tax credit status reports, make the most 
appropriate selection in each of the following NAHMA fields: 

 
 

Relationship Type 
 

Employment Type 

Select the relationship type that identifies this person as household head. 
 
Select the person’s type of employment. 

 
 

5 Select a letter and correspondent for verifying information for this person. 
 
6 Click Save. 



 
 
 

Documenting LIHTC Household Members 
 
You must document all persons living in the unit with the household, whether or not those persons are 
considered to be family members. Examples include elderly parents, dependents, foster children, fos-
ter adults, and live-in aids. 
 
 

To document an LIHTC household member 
 
1 On the Family Members tab, click the Add New Member link. The Member screen appears. 
 
2 Add all information needed for this member. 
 
3 Click Save. 
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LIHTC Family Income Documentation 
 
 

In this lesson 
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This lesson explains how to document household income when you are qualifying a household for 
LIHTC housing. 
 

Voyager Affordable Housing also includes HUD project-based programs, Rural Development Section 515, and the 
HOME Investment Partnership housing programs. Voyager configures the Income Record screen based on the 
housing programs under which a property operates. If a property operates under more than one housing program, the 
screen examples and information described in this lesson will vary from the Voyager screens that you see. 

 
 
 

Introduction to Family Income Documentation 
 
Annual family income determines the household’s eligibility for affordable housing. Examples of 
income are wages and salaries from employment, profits from a business, public assistance payments, 
and pensions. You must document income from all sources unless you have a specific reason to 
exclude the income such as a statute or law. 
 

In this lesson, you will learn how to document earned and unearned annual income. 
 
 



 

 
 
 
The following chart shows the leasing workflow for LIHTC housing applicants. The Income 
qualifica-tion step is the subject of this lesson. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 

Documenting Family Income 
 
For establishing household income, affordable housing program documentation often refers to house-
hold members as family members. Examples of family members are household heads, spouses, co-heads, 
and dependent children of family members. 
 
You must document all income for adult family members and children over the age of eighteen who are 
not dependent full-time students. You must also document the first $480 of earned income for full-time 
students over the age of eighteen, unearned income for dependent children under the age of eighteen, 
and all income of foster adults. 
 

You must include the earned income of foster adults. You must also include unearned income of foster children, except 
payments that the family receives from official foster-care relationship sources for the care of a foster child or adult. 
LIHTC uses the HUD rules for income documentation. For information about income limits and family size, see HUD 
Handbook 4350.3 REV–1, CHG–4, par. 5-6. For information about household members whose income is to be included 
or excluded, see HUD Handbook 4350.3 REV–1 CHG–4. Figure 5-2. 

 
 
You must separately document each income source. For example, if a family member has two jobs, 
document each job separately. 
 
 

To document family income 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 
3 Select the Income qualification step. The Income tab appears in the bottom part of the screen. 
 

Income 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Income tab Add New Income 



 
 
 

To document family income 
 
1 Click the Add New Income link. The Income Record screen appears. 



 
 
 

2 In the Income Data section, complete the following fields as needed: 
 
 
 

Member 
 
 

Income Source 

The name of the household head automatically appears. If this income is for another 
family member, select that person 
 
Select the source of this income. Options are: 
 

PE–Pension Veterans’ pensions, military retirement, or income from all other pensions and 
annuities. 
 

A–TANF Income from Temporary Assistance for Needy Families. 
 

SS–Soc Sec Social Security income. 
 

G–Gen Asst Income from any general assistance sources. 
 

SI–SSI Supplemental Social Security income. 
 

CS–Child Support Income from child support that the member receives. 
 

M–Military Income from military sources. 
 

F–Federal Income from federal government sources. 
 

W–Non-Fed Salaries, wages, tips, commission bonuses, or other income from non-
government sources. 
 

U–Unemployment Income from unemployment compensation. 
 

I–Indian Trust Income from an established Indian trust. 
 

B–Business Income from business sources, including distributed profits and business net 
income. 
 

N–Other Income from any other source, such as alimony, that the member receives. 
 
 

3 If your state agency or management organization requires you to document the member’s occupa-
tion or the ZIP code for the area in which the member earns this income, complete the Occupation 
and Occupation ZIP Code fields. 

 
4 If the person receives this income under a Social Security number that is different from the mem-

ber’s own Social Security number, type in the SSN Claim Number field the Social Security claim 
number under which this family member receives the income. 

 
Type this number only if this Social Security number is different from the member's own Social Security number. If 
needed, include the alpha/numeric suffix attached to the end of the Social Security claim number. 



 
 
 

5 Complete the information about the person’s pay period: 
 
 

Payment Frequency 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pay periods per year 

Select the rate of occurrence for the income payments. Options are: 
 

Hourly The member receives a check or a payment for each hour worked. 
 

Daily The member receives a check or a payment for each day worked. 
 

Weekly he member receives payment once a week. 
 

Bi-weekly The member receives payment once every two weeks. 
 

Semi-monthly The member receives payment twice each month. 
 

Monthly The member receives payment once each month. 
 

Annual The member receives an annual salary. 
 

Other The member receives payment in some other kind of period. 
 
Voyager automatically completes this field by calculating the number of regular payment 
periods per year, based on the Payment Frequency field. If the number of payment periods 
differs from the number displayed, type the number of times per year that the member 
receives the income payments. 
 

For example, if the person is paid monthly and works the entire year, you would type 12. If the 
person is paid weekly and works 50 weeks per year, you would type 50. 

 
 

6 Complete the Current Wages section to document the person’s current payment and payment 
period. 

 
 

Reg Rate 
 
 
 
 
 
 
 
 
 
 
 
 

OT1 Rate 
 
 

OT2 Rate 

$/Hour In the Reg Rate row, type the dollar amount that the member regularly receives for 
each income payment period. 
 

For example, if the payment frequency is weekly, the member is paid $8 per hour, and you 
want to calculate the income at the hourly rate, you would type 8. If the payment frequency 
is weekly and the member receives a paycheck of $300 each week, you would type 300. 
 

In the Reg Rate row, type the number representing the payment period for the income that 
you typed in the $/Hour field. 
 

For example, if the payment frequency is weekly, the member works 40 hours per week, and 
you want to calculate the income at the hourly rate, you would type 40. If the payment 
frequency is weekly and the member is paid $300 each week, you would type 1. 
 
If the person receives overtime wages, complete the overtime rate and period as you did for 
the member’s current regular rate. 
 
If the person receives additional overtime wages at a different rate, complete the second 
overtime rate and period as you did for the members current regular rate. 

 
 

7 Review the amount in each Total/Year field. Voyager automatically calculates these amounts, 
based on the $/Hour and Hrs/Period fields in each row. 



 
 
 

8 This member will be receiving a wage increase in five months. Complete the following fields in the 
Anticipated Wage Change section of the screen: 

 
 

Anticipated Wage Change 
 
 
 

New Rate 
 
 

New OT1 Rate 
 
 

New OT2 Rate 

Type the month, day, and year that the pay raise takes effect. Type this information without 
formatting. For example, if you typed 060114, Voyager would automatically format this date as 
06/10/2014. 
 
Complete the$/Hour and Hrs/Period fields for the anticipated wage change as you did for the 
member’s wages at the current regular rate 
 
If the person will receive overtime wages, complete the overtime rates and periods as you did 
for the member’s current regular wages. 
 
If the person will also receive overtime wages at a different rate, complete the overtime rates 
and periods as you did for the member’s current regular wages. 

 
 

The member’s total annual income at the new payment rate appears in the Annual Anticipated 
Income field. Voyager automatically completes this field based on the $/Hour and Hrs/Period fields 
for anticipated income. 

 

9 Review the following information. Voyager automatically calculates these amounts based on the 
number of days that the member received the income at the specified income rate. 

 
 

Income at Current Rate (# Days) 
 

Income at New Rate (# Days) 
 
 

Total Annual Wage 

The total current income for the number of days as displayed in the field label appears. 
 
The total anticipated income for the number of days as displayed in the field label 
appears. 
 
The sum of the total annual currant and anticipated income appears. 

 
 

10 If the person receives commissions, bonuses, tips, or other income connected with this income 
source, complete the following fields: 

 
 

Commissions, Bonuses, Tips, etc 
 
 
 
 
 

Other Annual Amount 

If this family member receives income from commissions, tips, bonuses, or similar sources, 
type the annual amount received. 
 

For example, if the member averages $120 each week in tips and the member works 50 
weeks per year, the member would earn $6000 annually in tips ($120 x 50 weeks). 
 
If this family member receives income from other miscellaneous sources, type the annual 
income amount received. 

 
 

11Review the amount in the Income/Year field. Voyager calculates this amount, based on all informa-
tion in the previous fields. 



 
 
 

12 If you need to alert your staff to refer to the paper files for the household or other documentation for 
income calculation details, click the See File Copy for Calculation check box. 

 
For example, a member may have more than one anticipated change in income per year, or other 
circumstances may make income calculations too complex to show in accurate detail. Clicking this 
check box alerts you or your staff to refer to paper files or other supporting documentation for more 
information. 

 
13 Leave the Date Verified field empty. If your management organization requires you to complete it, 

complete it after receiving the response to your verification letter and confirming that all informa-
tion on this screen is complete and accurate. 

 

14 If the property is located in a state that uses the NAHMA-XML standard for tax credit state reports, 
select in the Income Verification Source field the way that you will verify the income. 

 
15 Select a letter and letter recipient (correspondent) for verifying the income information. 
 

Letter button Correspondent button 
 
 
 
 
 
 
 
 
 
 
a Click the Letter button located to the right of the first Letter field. A selection list of letters 

appears. Select a letter and click OK. The selection list closes. The code of the selected letter 
appears in the Letter field. 

 
b Click the Correspondent button located to the right of the first Send To field. A selection list 

of correspondents appears. Select a correspondent and click OK. The selection list closes. The 
code of the selected correspondent appears in the Send To field. 

 

If you are sending a letter and have not already set up the correspondent, you must set up the 
correspondent before you can select that correspondent. This guide explains how to add a 
correspondent in Chapter 2, “LIHTC Household Member Documentation.” If needed, refer to 
“Documenting LIHTC Household Heads” on page 23of that chapter. 

 
Date Sent and Response Date fields appear on each row so that you can type the date that you sent the letter 
and received a response. You can also record the sent and received dates later at the Verification step. In the 
Verification step, you can record these dates for all selected member, income, asset, and expense verification 
letters. 

 

In this lesson, do not type a date now. You will type the dates when you complete the Verification step. 



 
 
 

16Carefully review all information on the Income Record screen to ensure that it is complete and cor-rect. 
 

The following graphic shows an example of the Income Record screen completed for employment 
income. This person is paid bi-weekly and works 26 weeks per year. She expects a monthly wage 
increase beginning July 1, 2014. She receives an annual bonus of $200.00. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Current wages 
 
 
 
 
 

Anticipated wage increase 
 
 
 
 
 

Member’s annual bonus 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
17When you are finished, click Save to close the screen and return to the Income tab. 
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This lesson explains how to document family assets when you are qualifying a household for LIHTC 
housing. 
 

Voyager Affordable Housing also includes HUD project-based programs), Rural Development Section 515, and the 
HOME Investment Partnership housing programs. Voyager configures the Asset Record screen based on the housing 
programs under which a property operates. If a property operates under more than one housing program, the screen 
examples and information described in this lesson may vary from the Voyager screens that you see. 

 
 
 

Introduction to Family Asset Documentation 
 
A household’s annual income includes income from family assets. Assets are cash or items of value that 
may be turned into cash. Examples of assets are cash, checking accounts, savings accounts, shares of 
stock, and real estate. One-time payments are usually considered to be assets. You must document all 
income from assets. 
 
In this lesson, you will learn how to complete the following tasks: 
 

• Document income from assets that family members currently hold. 
 

• Document income from imputed assets. 



   
 

The following chart shows the leasing workflow for LIHTC housing applicants. The Assets 
qualification step is the subject of this lesson. 
 
 



 
 

 

Documenting Income from Current Assets 
 
For affordable housing, assets consist of two types: current assets and imputed assets. Current assets 
are assets that a member of the family now owns. Imputed assets are assets that a family member sold 
or divested for less than fair market value within two years before the effective date of the household’s 
certification. 
 
You must document each family asset separately. For example, if a family member has two checking 
accounts at the same bank, document each account separately. 
 

When you are qualifying a household for LIHTC housing and the total value of the family’s assets is over $5000, you 
must use the higher of actual or imputed income. Imputed income is income that the asset would earn at the current 
passbook savings rate. 

 

Voyager simplifies these asset income calculations. If the total of family assets is over $5000, Voyager automatically 
compares imputed income to actual income and uses the greater amount for the certification. You do not need to 
manually calculate and compare actual and imputed income. 

 
 
To document income from a current asset 
 
1 Open the Prospect Guest Card screen for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 

3 Select the Assets qualification step. The Assets tab appears in the bottom part of the screen. 
 

Assets 
 
 
 
 
 
 
 
 
 
 

Assets tab 
 
 
 

Add New Asset 



 
 
 

4 Click Add New Asset. The Asset Record screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

pp 
 
5 In the Asset Data section, complete the following fields as needed: 
 
 

Member 
 
 

Description 
 
 

Status 
 

Date Divested 
 

Market Value 
 

Divestiture Cost 
 
 
 
 

Annual Interest 
 
 

Actual Income/year 
 
 
 
 

Date Verified 

The name of the household head automatically appears. If another family member is the owner 
of record, select that person. 
 
Type or select a brief description of the asset. Examples include checking accounts, savings 
accounts, IRA accounts, and stamp collections. 
 
Select C-Current. 
 
For a current asset, leave this field empty. 
 
Type the market value of the asset. 
 
For a current asset, type 0 (zero). 
 

Voyager automatically completes the Cash Value field. The cash value of the asset is the market 
value less the divestiture cost. 
 
Type the amount of interest that the asset earns per year. If the asset does not earn interest, type 
0 (zero). 
 
If you completed the Market Value and Annual Interest% fields, Voyager automatically 
completes this field. For assets earning income from a source other than interest, type the 
income per year that this asset produces. If the asset earns no income, leave this field at 0.00 
(zero). 
 
Leave this field empty. If your management organization requires you to complete it, complete 
it after you receive the response to your verification letter and confirm that all information is 
complete and accurate. 



 
 
 

6 If the property is located in a state that uses the NAHMA-XML standard for tax credit state reports, 
select in the Asset Verification Source field the way that you will verify the income. 

 
7 Select a letter and letter recipient (correspondent) or verifying the asset information. 
 

Letter button Correspondent button 
 
 
 
 
 
 
 
 
 
 
a Click the Letter button located to the right of the first Letter field. A selection list of letters 

appears. Select a letter and click OK. The selection list closes. The code of the selected letter 
appears in the Letter field. 

 
b Click the Correspondent button located to the right of the first Send To field. A selection list of 

correspondents appears. Select a correspondent and click OK. The selection list closes. The code 
of the selected correspondent appears in the Send To field. 

 
Date SentandResponse Date fields appear on each row so that you can type the date that you sent the letter and 
received a response. You can also record the sent and received dates later at the Verification step. In the 
Verification step, you can record these dates for all selected member, income, asset, and expense verification 
letters. 

 

In this lesson, do not type a date now. You will type the dates when you complete the Verification step. 



 
 
 

8 Carefully review all information to ensure that it is complete and correct. 
 

The following graphic shows an example of the Asset Record screen completed for a checking 
account that earns no interest. 

 
 
 
 
 
 
 
 
 
 

Asset cash value 
 

Annual interest percentage 
 
 

Annual asset income 
 
 
 
 
 
 
 
 
 
 
 
9 When you are finished, click Save to close the screen and return to the Assets tab. 
 
 

Documenting Income from Imputed Assets 
 
When a family has sold or divested an asset for less than fair market value within the previous two 
years before the effective date of the certification, you are required to calculate the imputed income 
from that asset. Imputed income is not actual income that the family receives. It is income that the 
asset would be expected to earn at the current passbook savings rate if the family currently owned the 
asset. 
 
 

To document income for an imputed asset 
 
1 Open the Prospect Guest Card screen for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 

3 Select the Assets qualification step. The Assets tab appears in the bottom part of the screen. 



 
 
 

4 Click Add New Asset. The Asset Record screen appears. 
 
5 In the Asset Data section, complete the following fields as needed: 
 
 

Member 
 
 

Description 
 
 

Status 
 

Date Divested 
 

Market Value 
 

Divestiture Cost 
 
 
 
 
 

Annual Interest 
 
 
 
 
 
 
 

Actual Income/year 
 
 
 
 
 
 
 

Date Verified 

The name of the household head automatically appears. If another family member is the owner 
of record, select that person. 
 
Type or select a brief description of the asset. Examples include checking accounts, savings 
accounts, IRA accounts, and stamp collections. 
 
Select I-Imputed. 
 
Type the month, day, and year that the person sold of divested this asset. 
 
Type the market value of the asset. 
 
Type the total cost that the member incurred to sell or divest the asset. If the member incurred 
no costs, type 0 (zero). 
 

Voyager automatically completes the Cash Value field. The cash value of the asset is the market 
value less the divestiture cost. 
 
For an imputed asset, type 0 (zero). Voyager calculates the income based on the passbook 
interest rate defined in Voyager System Administration. 
 

NOTE LIHTC requires property owners and management organizations to document income 
from an imputed asset at the HUD passbook interest rate current as of the certification effective 
date. Your database administrator defines the HUD passbook rate on the Affordable Options 
screen in Voyager System Administration. 
 
Voyager automatically completes the Actual Income/year field. The income per year is the 
market value multiplied by the annual interest rate percentage. 
 

NOTE HUD requires income from an imputed asset documented at the HUD passbook interest 
rate current as of the certification effective date. For the certification, Voyager will calculate the 
annual income for the certification based on the passbook percentage defined on the 
Affordable Options screen in Voyager System Administration. 
 
Leave this field empty. If your management organization requires you to complete it, complete 
it after you receive the response to your verification letter and confirm that all information is 
complete and accurate. 

 
 

6 If the prospect is qualifying for an LIHTC property located in a state that uses the NAHMA-XML stan-
dard for tax credit state reports, select in the Asset Verification Source field the way that you will 
verify the income. 

 
7 Select a letter and letter recipient (correspondent) for verifying the asset information. 



 
 
 

8 Carefully review the information to ensure that it is complete and correct. 
 

The following graphic shows the Asset Record screen for an imputed asset, a real estate property 
that the family member had sold for less than fair market value within two years previous to the 
certification-effective date. The member paid $14,000 in expenses to sell the real estate. The imputed 
interest rate is 2%. 

 
 
 
 
 
 
 
 
 
 

Asset cash value 
 

Annual interest percentage 
 
 

Annual asset income 
 
 
 
 
 
 
 
 
 
 
 
9 When you are finished, click Save to close the screen and return to the Assets tab. 
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LIHTC Household Information 
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In this lesson, you have documented information needed for each member of an LIHTC household. 
This lesson explains how to complete the additional information that applies to the entire household. 
 

Voyager Affordable Housing also includes LIHTC (Low Income Housing Tax Credit), Rural Development Section 515, 
and the HOME Investment Partnership housing programs. Voyager configures the Household Info screen based on 
the housing programs under which a property operates. If a property operates under more than one housing program, 
the screen example described in this lesson will vary from the Voyager screen that you see. 

 
 
 

Introduction to LIHTC Household Information 
 
After you have documented the details for each household member, you are ready to add the informa-
tion that applies to the entire household. 
 

• If the household is qualifying under a student exception, you must identify the exception. 
 

• Some states have special social services programs available for LIHTC families. If the family is 
receiv-ing social services under one of these programs, you must identify the household as a 
social-ser-vices family. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 

 
 
The following chart shows the leasing workflow for LIHTC housing applicants. The Household 
Info qualification step is the subject of this lesson. 



 
 
 

 

Documenting LIHTC Household Information 
 
Although most of the information needed for qualifying a household applies to individual members, some 
information applies to the household as a whole. For LIHTC, household information applies for full-time 
students and social services provided to the household. Your final step before verification is to add this 
information for the household. 
 
 

To document household information for LIHTC 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 

3 Select the Household Info qualification step. The Household Info tab appears in the bottom part 
of the screen. 

 
 

Household Info 
 
 
 
 
 
 
 
 
Household Info tab 
 
 
 
 

4 Complete the following fields as needed: 
 
 

Student Exception 
 
 

PSR Social Services 

If the household is composed entirely of full-time students, select the student exception 
that makes this household eligible for LIHTC housing. 
 
If the household receives social services required to be reported in tax 
credit state reports, select Yes. Otherwise, select No. 

 
 

5 When you are finished, click Next. The Verification tab appears in the top part of the screen. 
 
You are ready to verify the information that you have documented. 
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This lesson explains how to print the verification letters that you selected for verifying family members, 
income, and assets, and how to confirm that the household qualifies for the project. 
 
 

Introduction to Verification and Validation 
 
Verification confirms the accuracy of information that household members supply when they are qual-
ifying for affordable housing. Verification provides documented evidence that a household is qualified. 
Affordable housing programs prefer third-party written verification. 
 

Validation determines whether or not a household qualifies for LIHTC housing based on the informa-
tion that you have received and verified. For a move-in, validation only determines whether the house-
hold is qualified for the project. It does not confirm that a household is qualified for a specific unit. 
 
In this lesson, you will learn how to complete the following tasks: 
 

• Print the verification letters that you have previously selected. 
 

• Record verification letter-sent dates. 
 

• Record verification letter-response dates. 
 

• Record verification confirmation dates for income and assets. 
 



 
 
 

The following chart shows the leasing workflow for LIHTC housing applicants. The Verification and 
Validation  qualification steps are the subject of this lesson. 
 

 
 
 
 



 
 
 

Printing Verification Letters 
 
When you documented household member, family income, and family assets for an LIHTC household, 
you selected verification letters and correspondents (letter recipients) for verifying that information. 
You can print in a single process one letter, several letters, or all of your selected verification letters. 
 
 

To print verification letters 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 
3 Select the Verification qualification step. The Verification tab appears in the bottom part of the 

screen. This tab displays all of the letters that you selected when you added the family member, 
income, and asset information for the household. 

 
 
 
 
 
 

Verification 
 
 
 
 

Letters 
button 

 
 
 
 
 
 
 
 
 
 
 

4 Click the Letters button. 
 

• If your database is set up to use only the standard Voyager letters, the letters appear. 
Standard letters are in an Adobe PDF format. 

 

• If your database is set up for custom MS Word verification letters created with Yardi FillDocs 
and you have selected letters of more than one format, a Documents to download screen 
appears with links to the letters in each format. Click the link for the letter that you want to 
print. The let-ter appears. 



 
 
 

You can use the scroll bar that appears on the right side of your screen to view all of the verification 
letters. 

 
The following graphic shows an example of a standard Voyager income verification letter as it 
appears on the screen. The position and appearance of the buttons depends on the browser that you 
are using. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5 Print the letters. 
 
After printing and sending the letters, you are ready to document the dates that you sent them. Voy-
ager tracks an unanswered letter by it’s letter-sent date. 
 

Tracking unanswered verification letters is critical for on-time certification completion. 
 

Voyager tracks the number of unanswered days from the letter-sent date. After the maximum number of days pass, 
Voyager adds the letter to the Unanswered Letters list on the Community Manager Dashboard screen. You can click 
the Unanswered Letters link on the Community Manager Dashboard screen and review letters for which you have 
not received responses. 



 
 
 

To document the date that you send verification letters 
 
1 Take one of the following steps: 
 

! If you want to document all letters as sent on the system date of your workstation, click the Send 
button. Voyager enters the system date in the Date Sent field for all letters on the list. 

 
 
 
 
 
 

Verification 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Date sent 
 

! If you want to document a different letter-sent date for a specific letter, type the date in theDate 
Sent field for that letter. 

 
 
 
 
 
 

Date sent 



 
 
 

Recording Verification Letter Response Dates 
 
Documenting a response date for a verification letter confirms that you received a response to the let-
ter. Recording a response date also confirms that you have reviewed the letter and if needed updated 
your records so that the information in your records matches the information in the letter. 
 
 

To document the date that you received a verification letter response 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 
3 Select the Verification qualification steps. The Verification tab appears in the bottom part of the 

screen. This tab displays all of the letters that you selected when you added the family member, 
income, asset, and expense information for the household. 

 

4 On the row displaying the verification letter for which you have received a response, click the Edit 
link. 

 
 
 
 
 
 
 
 
 
 
 
 

Edit link 



 
 
 

The information that you are verifying appears. 
 
5 Carefully review the information and update it with any needed changes. 
 
6 In the Response Date field on the row displaying the letter, type the date that you received the 

response. 
 
7 The Income Record and Asset Record screens have a Date Verified field for recording the date 

that you verified the information. If your management organization requires you to complete the 
Date Verified field, type the date that you verified the information and if needed updated the 
record based on the verification response. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Date Verified 
 
 
 
 
 
 
 

Response Date 



 
 
 

8 When you are finished, click Save. The screen closes. The response date appears in the Response 
Date field on the Verification tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Response Date 
 
 
 
 
 
 
 
 

9 Repeat these steps for each verification response that you receive. 
 
 

Validating Eligibility 
 
Validation determines whether or not a household qualifies for LIHTC housing based on the informa-
tion that you have received and verified. 
 
 

To validate a household’s eligibility 
 
1 Open the prospect guest card for the household that you are qualifying. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Stepsmenu appears in the top part of the screen, on the right. Verifica-
tion should be the selected leasing step. 

 
3 Click Next. Validation is now the selected qualification step. The Validation tab appears in the bot-

tom part of the screen. 



 
 
 

4 Carefully review the validation information. 
 

! If the household qualifies, you see a Qualified Household heading followed by summary infor-
mation for the tenant income certification. 

 

! If the household does not qualify, you see an Unqualified Household heading and a descrip-tion 
of the reason. You will be unable to select a unit for the household. 

 
Validation 

 
 
 
 
 
 
 
 
 
 

Qualified 
household 

 
 
 
 
 
 
 
 
 
 
 

 
You can help prevent fraud by confirming that no member of this household is using the same Social Security number 
as another resident in this or another property. Clicking the Occupancy Check button displays the Duplicate SSN 
report. If a Social Security number for a member of this household duplicates the number of another resident in your 
database, the report shows information about that other resident. 

 
 
 

5 Confirm that the household qualifies for the project. 
 
6 Click the Occupancy Check button and review the Duplicate SSN report. Confirm that no member 

of this household has a Social Security number that duplicates the Social Security number of 
another resident in your database. 
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This lesson explains how to select a unit for a qualified LIHTC applicant household. 
 
 

Introduction to LIHTC Unit Selection 
 
Selecting a unit assigns that unit to the household. If the property is set up so that only one household 
can be assigned to a unit, selecting a unit for a household makes it unavailable for selection by any 
other household. 
 

In this lesson, you will learn how to complete the following tasks: 
 

• Review unit information during the unit selection process. 
 

• Select a unit for a qualified prospective LIHTC household. 
 

• Deselect the assigned unit and select a different unit for the household. 



 
 
 
 

The following chart shows the leasing workflow for LIHTC housing applicants. The Select Unit qualifi-
cation step is the subject of this lesson. 
 

. 



 
 
 

Selecting a Unit for a Qualified Prospective LIHTC Household 
 
After you have completed the qualification process for an LIHTC prospect household and determined 
that the household is qualified for the project, you are ready to select a unit. When you select a unit 
after qualifying a household for the project, Voyager displays only available units that the household is 
qualified to occupy. 
 
 

To select a unit for a qualified LIHTC household 
 
1 Open the prospect guest card for the household that you have qualified for the project. 
 
2 On the Select Unit leasing step, click the Compliance button. The Prospect Certification screen 

appears. The Qualification Steps menu appears in the top part of the screen, on the right. 
 

3 Select the Validation step and review the information to ensure that the household is qualified for 
the project. 

 

4 Click the Next button. The Select Unit tab appears in the bottom part of the screen. The Lease 
From Date is automatically highlighted. 

 
Select Unit 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Available units 
 
 
 
 
5 Press the TAB key on your workstation. Voyager automatically completes the Lease To Date field 

based on the information in the Lease From Date and Lease Term (months) fields. 
 

The Lease From Date shows the expected move-in date that you entered when you added the household’s guest 
card. The Lease Term in Months field shows the standard leasing term set up for the property. If needed, you can 
change this date and term. 



 
 
 

6 If needed, you can review unit information during the unit selection process. 
 

! If you want to review information about a specific unit, click the unit code on the row for that 
unit. The Unit screen appears. When you are finished, close the Unit screen. 

 

! If you want to review the information about the unit type, click the unit type code in the field for 
that unit. The Unit Type screen appears. When you are finished, close the Unit or Unit Type 
screen. 

 

You are ready to select a unit for this household. 
 
7 On the row displaying the unit that you want to select for the household, click the Select link. 
 

You have assigned the unit to the household. The unit code appears in the Unit field in the top part 
of the screen. The Select link on the row for the selected unit changes to Deselect. 

 

The following graphic shows the Select Unit tab with a unit selected. In this example, the selected 
unit is unit 5A. 

 
Selected unit and lease dates 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selected unit 
 
 
 
 
 

To deselect the assigned unit and select a different unit 
 
1 On the row displaying the selected unit, click the Deselect link. 
 

The unit is no longer selected. The Unit field in the top part of the screen is empty. The Deselect link 
changes to Select. 



 
 
 

2 On the row displaying the unit that you now want to assign to the household, click the Select link. 
 

You have selected that unit for the household. 
 
 

To complete the unit selection process 
 
" Click the Done button located in the top part of the screen. The Prospect Guest Card screen 

appears, and the Rental Options tab appears in the bottom part of the screen. 
 

Rental Options 
 
 
 
 
 
 
 
 
 
 
 
 

Rental Options tab 
 
 
 
 
 
 
 
 
You have finished the affordable housing qualification and unit selection process. You are ready to pro-ceed 
with the lease. 
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This lesson explains how to complete the final applicant approval and lease execution process for a 
qualified LIHTC household. 
 
 

Introduction to LIHTC Applicant Approval and Lease 
Execution 
 
After you have qualified an LIHTC prospect household and assigned a unit, you are ready to approve 
the application and execute the lease. 
 

In this lesson, you will learn how to complete the following tasks: 
 

• Approve an LIHTC household for move-in. 
 

• Review and print the tax credit tenant income certification for an approved households. 
 

• Execute an LIHTC household’s lease. 



 
 
 

The following chart shows the leasing workflow for LIHTC housing applicants. The final four leasing 
steps, Rental Options, Concessions, Approval, and Execute Lease, are the subject of this lesson. 
 
 
 
 
 



 
 
 

Completing the LIHTC Applicant Approval and Leasing Process 
 
After you have qualified an LIHTC applicant household and assigned a unit, you are ready to approve 
the household for move-in and execute the lease. 
 
 

To complete the application and lease execution process 
 
1 Open the prospect guest card for the household that you are qualifying. The Prospect Guest Card 

screen appears. Rental Options is the selected leasing step. The Rental Options tab appears in the 
bottom part of the screen. 

 
! Rental options are leasing or other contract options. An example is a shorter lease term than you 

usually require. 
 

! Rentable items are items available for rent in addition to a resident’s unit. Examples are a refriger-
ator or a parking space. 

 

In the following graphic, no rental options or items are set up for the selected unit. 
 

Rental Options 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rental Options tab 



 
 

2 Click Next to advance to the Concessions leasing step. The Concessions tab appears. 
 

Concessions are items of value or benefits offered during lease negotiations. An example is a free 
month of rent offered as a leasing incentive. If concessions are set up in Voyager for the selected unit, 
the Concessions leasing step displays them. 

 
Most LIHTC properties do not use concessions. In the following graphic, no concessions or items are set 
up for the property. 

 
Concessions 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Concessions tab 
 
 
 
 

3 Click Next to advance to the Application Form leasing step. The Application Form tab appears, 
showing the names of the household head and each member whom you added as an occupant. 

 
Application Form 

 
 
 
 
 
 
 
 
 
 
 
 
 

Application Form 
tab 

 
 
 
 
 

You can record on the application form additional information that was not part of the household’s 
qualification documentation. Vehicle and emergency contact information that you add on the 
application form will appear on the Resident screen. 



 
 
 

4 If you want to add additional details to a household’s application, take the following steps: 
 

! For the household head, click the Application Information link. 
 

! For household members listed as occupants, click the Occupant Information link. 
 

The Application screen appears. 
 

Add the needed information. If you want to print the application form, click the Print button. When 
you are finished, click Save. The Application screen closes. 

 

5 When you are ready to proceed, click Next to advance to the Application Charges leasing step. 
The Application Charges tab appears. 

 

Application charges are set up by unit type. The charges that appear are the charges set up for the 
unit type assigned to the household’s selected unit. The default charge date is the system date on 
your workstation. 

 
6 If application charges are available for this unit, select the charges that you want to create for the 

household. 
 

Completing the Application Charges leasing step changes the household’s rental status prospect to pending 
applicant. Voyager automatically removes the household from the prospect pipeline and adds the household to the 
list of pending applicants. The Prospect Pipeline total on the Community Manager Dashboard screen decreases 
by one and the and the Pending Applications total increases by one. 

 
 

In the following graphic showing the Application Charges tab, charges are set up for application 
processing and credit reports. Both charges are selected. 

 
Application Charges 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Application 
Charges tab 

 
 
 
 
 
 
 

Selected application charges 



 
 
 

7 Click Next. A confirmation message appears for posting the selected application charges. 
 
8 Click OK. Voyager advances to the Application Status leasing step. The Application Status tab 

appears. 
 

Prospect status Application Status 
 
 
 
 
 
 
 
 
 
 
 
 
 

Application Status 
tab 

 
 
 
 
 

The household is now a pending applicant. At this step, you can review the tenant income 
certification to ensure that it is complete and correct before approving the household. You can also 
print copies of the certification. 

 

• If you want to review the certification, click the Edit TIC button. The Tax Credit screen 
appears. this screen contains a summary of the resident’s tenant income certification. 

 

• If you want to review the family details, click Edit TIC to display the Tax Credit screen. Click 
the Family Info button in the top part of the Tax Credit screen and then click each menu item 
on the Qualification Steps menu. When you are finished, close the Tax Credit screen. 

 

• If you want to print a copy of the tenant income certification form, click Edit TIC to open the Tax 
Credit screen. On the Reports menu in the top part of the Tax Credit screen, select the 
certifica-tion form and then click the Go button. The form appears. You can print the displayed 
form. When you are finished, close the screen displaying the form and then close the Tax 
Credit screen. 

 
 

You can also adjust the move-in date, assign the household to a different unit, cancel the household, or deny the 
household, if needed. 

 

If you adjust a household’s move-in date before you approve the household, Voyager requires you to repeat the 
qualification steps. When you proceed through the steps after adjusting a move-in date, you do not need to change 
any information or reselect the applicant’s unit. 

 
 

In this lesson, we will approve the household for move-in. 



 
 
 

To approve an LIHTC household for move-in 
 
1 On the Application Status tab, click the Approve button. The Approval screen appears. 
 
 
 
 
 
 
 
 
 

2 Complete the screen: 
 
 

Date The system date on your workstation appears. If needed, type a different date. 
 

Agent The leasing agent initially assigned on the household’s guest card appears. If needed, select 
a different agent. 

 
 

3 Click Save. A confirmation message appears. Click OK. 
 

The Application Status tab appears. You have approved the household and are ready to record the 
lease execution date. 

 
Approved status 

 
 
 
 
 
 
 
 
 
 
 
 
 

Application Status 
tab 



 
 
 

To record the lease execution date for an approved LIHTC household 
 
1 On the Application Status tab, Click the Execute Lease button. The Lease Sign screen appears. 
 
 
 
 
 
 
 
 
 

2 Complete the screen: 
 
 

Date The system date on your workstation appears. If needed, type a different date. 
 

Agent The leasing agent initially assigned on the household’s guest card appears. If needed, select 
a different agent. 

 
 

3 Click Save. A confirmation message appears. Click OK. The Resident screen appears. 
 

The household is now a future resident in the property. The status on the Resident screen is Future. 
You are ready to process the move-in. 

 
Future resident status 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Link to TIC 



 
 
 

The Affordable tab shows information about the move-in TIC, including the effective date and rent 
payment information. Three links appear for the certification: MI, Print, and Edit. 
 

• Clicking MI opens the Tax Credit screen. 
 

• Clicking Print displays the state tenant income certification (TIC). You can print the TIC or save 
it as a file on your workstation or network. You must provide a copy of the TIC for 
property owners and all adult members of the household to sign before move-in day. 

 

• Clicking Edit opens the qualification steps. You can review the information or make needed 
changes before you record the date completed. If you make changes after household 
members have signed the certification, print a new copy for all household members to sign. 
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This lesson explains how to complete a move-in for an LIHTC household. 
 
 

For this lesson, you have completed the qualification process, executed the household’s lease, and recorded 
the date-completed on the Tax Credit screen. The household is a future resident ready for move-in. 

 
 
 

Introduction to LIHTC Move-In 
 
After you have qualified an LIHTC household and executed the lease, you are ready to proceed with 
the move-in. Completing a move-in establishes the household as a current resident of the property 
and completes the qualification and leasing workflow for that household. 
 
In this lesson, you will learn how to complete the following tasks: 
 

• Adjust move-in dates when needed. 
 

• Record the completion date on a move-in TIC. 
 

• Move in the household. 
 
 

Voyager helps you to quickly complete Voyager screens. For fields that you can complete by typing, typing the first few 
characters automatically displays a selection list based on information that you previously used in that field. You can 
either select from the displayed list or complete the field by continuing to type. 



 
 

Adjusting Move-In Dates for Future Move-Ins 
 
Although many households move in on their scheduled move-in dates, occasions occur in which the 
move-in is either delayed or moved forward. When you adjust the move-in date, Voyager automati-
cally adjusts the move-in date and certification-effective date on the Tax Credit screen and adjusts the 
move-in date on the Lease Info tab of the Resident screen. 
 
! If you adjust the lease-from and lease-to dates when you adjust the move-in date, Voyager updates 

that information in the Resident screen. 
 
! If you had added the certification-completed date on the Tax Credit screen, adjusting the move-in 

date clears that date. 
 

TheMove In total on the Community Manager Dashboard screen includes households with exe-
cuted leases that begin on your workstation’s system date and households with executed leases that 
begin on days in the past but the move-in has not been recorded. TheMove In total does not include 
move-ins scheduled for future days. When you need to adjust a move-in date for a household with an 
executed lease that begins in the future, you must adjust the date from the Resident screen. 
 
 

To adjust the move-in date for a household scheduled to move in on a future date 
 
1 Open Resident screen for the future resident household. 
 
a On the Community Manager Dashboard screen, click the Person Search tab. The Person 

Search tab appears in the bottom part of the dashboard. 
 

b In theName field, type the first or last name of the household head and then click the Search but-
ton. A list of people who match your selection criteria appears. 

 

c Click the name of the household head. The Resident screen appears. The household’s rental status 
is Future. 

 
2 From the Functions menu of the Resident screen, click Adjust Move In Dates. 
 

Adjust Move In Dates 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Adjust Move In Dates screen appears. 



 
 
 

3 Adjust the date in one or more of the following fields as needed: 
 
 

Move In Date 
 

Lease From Date 
 
 

Term # Months 
 
 

Lease to Date 

Type the new move-in date. 
 
Type the new date that the lease begins and press the Tab key. Voyager automatically adjusts 
the date in the Lease To Date field according to the lease term. 
 
Type the new lease term and press the TAB key. Voyager automatically adjusts the date in the 
Lease To Date field according to the adjusted lease term. 
 
Type the date that the adjusted lease ends. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 Click Post. Voyager adjusts the dates. The Resident screen appears. A confirmation message for the 
lease-date adjustment appears in the top part of the screen. 

 
5 Click the Lease Info tab and review the new lease-sign and move-in dates. 
 
6 Click the Affordable tab and then click the MI link. The Tax Credit screen appears. Review and save 

the information. 
 

You will need to print new copies of the TIC for the property owners and adult household members 
to sign. If you had recorded date completed on theTax Credit screen, Voyager cleared the date when 
you adjusted the move-in date. 

 
 

Adjusting Move-In Dates on Move-In Day 
 
The easiest way to adjust a household’s move-in date when that date is on or before your workstation’s 
system date is to adjust the date from the Community Manager Dashboard screen. 
 
TheMove In total on the Community Manager Dashboard screen includes households scheduled 
for move-in on the current day or on a date before the current day. Clicking that total opens the Move 
In tab in the bottom part of the screen. 



 
 
 

To adjust the move-in date for a household scheduled to move in on or before the current date 
 
1 On the Community Manager Dashboard screen, click the number to the right of the Move In 

heading. The Move In tab appears in the bottom part of the dashboard. 
 
 

Move In 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move In tab 
 
 
 
 
 
 

Adjust Dates 
 
 

2 On the row displaying the resident for which you are adjusting the move-in date, click the Adjust 
Dates button . The Adjust Move In Dates screen appears. 

 

3 Adjust the date in one or more of the following fields as needed: 
 
 

Move In Date 
 

Lease From Date 
 
 

Term # Months 
 
 

Lease to Date 

Type the new move-in date. 
 
Type the new date that the lease begins and press the Tab key. Voyager automatically adjusts 
the date in the Lease To Date field according to the lease term. 
 
Type the new lease term and press the TAB key. Voyager automatically adjusts the date in the 
Lease To Date field according to the adjusted lease term. 
 
Type the date that the adjusted lease ends. 

 
 

4 Click Post. Voyager adjusts the dates and displays a confirmation message. Click OK. 
 

You will need to print new copies of the TIC for the property owners and adult household members 
to sign. If you had recorded the certification completed date on the Tax Credit screen, Voyager 
cleared that date when you adjusted the move-in date. You will need to type a new certification-
completed date and save the certification again. 



 
 
 

Printing Tenant Income Certification Forms 
 
The property owners and all adult household members must sign a printed copy of an annual recertifi-
cation. By signing a tenant income certification (TIC), each person is confirming that the information is 
complete, accurate, and represents the financial condition and composition of the household as of the 
certification-effective date. 
 
You can print copies of the certification form when you are reviewing the Tax Credit screen. Print cop-
ies for property owners and all adult household members to sign. 
 
 

To print a tenant income certification from a the Tax Credit screen 
 
1 If the Tax Credit screen is not open, open it. 
 
2 In the Reports field in the top part of the Tax Credit screen, select one of the following: 
 
 

NCSHA TIC 
 

State TIC 

Print the TIC form from the National Council of State Housing Agencies. 
 
Print the TIC form used by the state in which the property is located. 

 
 

3 Click Go. Adobe Reader opens. You can use the scroll bar at the right side of the screen to review all 
included pages. 

 

" If you selected NCSHA TIC, the National Council State Housing Agencies form appears. 
 

" If you selected State TIC, the tenant income certification form appears for the state in which the 
property is located. 



 
 
 

The following graphic shows an example of a state TIC certification form. The document that you 
see will be the TIC for your state. The position and appearance of the buttons depends on the 
browser that you are using. In this example, the Print button is located in the top part of the 
screen, above the displayed form. 

 
Print button 



 
 
 

4 Review all pages of the printed form. 
 
5 When you are ready to print, click the Print button. A Print dialog box appears. 
 
6 Ensure that your printer settings are correct and that you have selected the number of copies that 

you want to print. 
 
7 Click the Print button in the dialog box. Your printer prints the TIC. 
 
 

You can also print copies from the Resident screen. Open the Resident screen. You will see on the Affordable tab a 
summary of the resident’s certifications. A Print link appears on each row of the certification summary. 

 
 

Recording Completion of the Move-In Tax Credit Certification 
 
You cannot move in an LIHTC household until all adult household members have signed the tax credit 
certification. Recording the date that the certification was completed confirms that all family members 
have signed a printed copy of the TIC form. 
 

After you have recorded and saved the date that a TIC became complete, you cannot make further changes to the TIC. 
Ensure that the information is complete and accurate and that all adult household members have signed before you 
record the date-completed. 

 
 

The Resident Activity section on the Community Manager Dashboard screen displays the total 
number of incomplete certifications for a selected property. You will open the Tax Credit screen from 
the Incomplete Certs list. 
 

A household’s resident record also includes a summary of each certification. If needed, you can review a household’s 
TIC from the Resident screen. 



 
 
 

To record the date that a tax credit certification complete 
 
1 In the Resident Activity section on the Community Manager Dashboard screen, click Incom-
plete Certs. 

 

The Incomplete Certs summary appears in the bottom part of the dashboard. The Prog Type field 
displays the type of certification that is incomplete for each resident. The Cert Type field displays a 
link to that certification. 

 
Incomplete certifications link 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Incomplete Certs 
tab 

 
 
 
 
 

MI link 



 
 
 

2 In the Cert Type field for the future resident that you want to review, click the MI link. The Tax 
Credit screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tenant and 
subsidy charges 

 
 
 

Date Completed 
 
 
 
 
 
 
 
 
 
 
 
 

Link to Property Compliance Monitor screen NAHMA fields 
 
 

A Check Compliance link appears in the bottom part of the Tax Credit screen. You can click this link to open the 
Property Compliance Monitor screen and review the compliance condition of the property if this household 
moves in. The compliance monitor shows the affect of the move-in on the project’s minimum set-aside and the first-
year applicable fraction of the building that contains the household’s unit. 

 

During setup when you have not yet added all of the property’s existing households to your database, the 
Compliance Monitor screen will not accurately show the property’s compliance condition. 



 
 
 

3 In the Tax Credit Summary Record section of the screen, review the following fields. 
 
 

Tenant Rent 
 

Utility Allowance 
 

Other Non-Optional Changes 

The amount of rent that the resident will pay appears. Make adjustments if needed 
 
The utility allowance for the unit appears. Make adjustments if needed. 
 
If needed, type the total amount of miscellaneous charges that you require of this 
resident. 
 

NOTE The total amount of the tenant rent, the utility allowance, and other non-optional 
charges cannot be greater than the amount in the Total Rent field. Make adjustments if 
needed. 

 
 

4 Complete the following fields if needed: 
 
 

Utility Reimbursement 
 
 

Subsidy 

If you pay utility reimbursements to this resident, type the amount that you reimburse the 
resident for utility expenses. 
 
If you receive a tenant-based subsidy on behalf of the resident, type the subsidy amount. 
 

NOTE If the resident is also a HUD project-based resident, the project-based subsidy 
automatically appears in the Subsidy field. 

 
 

5 If your management organization submits tax credit state reports in the NAHMA-XML file format, 
complete the following fields in the NAHMA Fields section as needed: 

 
 

Household Type 
 

Subsidy Type 
 
 

Special Status 
 
 
 

Is Self Certified 

If needed, select the appropriate household type. 
 
If the household has an additional subsidy, select the type of subsidy. If the household has no 
additional subsidy, select NA - Not Applicable. 
 
If a special status applies to the household, select the special status. If more than one special 
status applies, select the household’s primary special status. If the household has no special 
status, select U-Undesignated or leave this field empty. 
 
If the family’s income for this certification is self-certified, select this check box. 

 
 

6 TheDate Completed field appears in the Tax Credit Summary Record section of the screen. When 
you are finished reviewing the certification and all adult household members have signed a printed 
copy of the certification form, type the date that the certification became complete. 

 
7 Click Save. You are ready to proceed with the move-in. 



 
 
 

Moving In LIHTC Households 
 
Processing a move-in posts move-in charges for the household and updates the household’s resident 
status. For LIHTC residents, Voyager posts rent charges due at move-in based on the accounts receivable 
month of the project. You can open the Resident screen and review the resident’s ledgers. 
 
 

To process a move for an LIHTC household 
 
1 On the Community Manager Dashboard screen, select the subject property. In the Resident 
Activity section of the dashboard, you see the total number of households ready for move-in. 

 
Completing a move-in automatically decreases the Move In number by one. 

 
 
 
2 Click the number to the right of the Move In heading. The Move In tab appears in the bottom part 

of the dashboard, displaying a list of residents ready for move-in. 
 

Number of households scheduled for move-in 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move In button for Lawrence Gibson 
 
 

3 On the row displaying the household that you are moving in, click the Move In button . 



 
 
 

TheMove In screen appears. Required move-in charges are automatically selected. If additional 
charges apply for the household, you can select those charges 

 
In the following graphic, deposit and prorated rent are automatically selected. The user has selected 
an additional charge for extra keys to the unit. 

 
 
 
 
 
 
 
 
 
 
 

Move-in and lease information 
 
 
 

Post button 
 
 
 
 

Selected move-in charges 
 
 
 
 
 
 

4 Review the move-in charges to ensure that they are complete and accurate. 
 
5 Click the Post button. Voyager processes the move-in and displays a confirmation message. 



 
 
 

You have completed the move-in. The Community Manager Dashboard screen appears. Voyager 
has decreased the total Move In number by one. 

 
Number of households scheduled for move-in 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You are ready to review the Resident screen and resident ledgers. 
 
 

Reviewing Ledgers for Tax Credit Residents 
 
Posting move-in adds move-in charges to the household’s ledgers. Voyager provides three ledgers 
that show these transactions: 
 

• Resident Ledger This ledger is the household’s complete ledger. You can review all 
transactions, paid and unpaid. 

 

• Ledger-HAP This ledger shows only housing assistance payment (HAP) transactions. If a 
house-hold has a subsidy, the subsicy transactions appear on this ledger. 

 

• Ledger-Non-HAP This ledger contains only transactions that are not housing assistance 
transac-tions. Examples include resident rent and miscellaneous charges. 

 

Voyager also provides ledger for reviewing only unpaid charges and pending payments. In this lesson, 
we will review the resident’s complete ledger and unpaid charges ledger. 



 
 
 

To review a household’s resident ledgers 
 
1 On the Community Manager Dashboard screen, click the Person Search tab. The Person Search 

tab appears in the bottom part of the dashboard. 
 

2 In the Name field, type the first or last name of the household head and then click the Search but-
ton. A list of people who match your selection criteria appears. 

 
3 Click the name of the household head. The Resident screen appears. The household’s rental status 

is now Current. 
 
 
 
 
 
 
 

Resident status 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4 From the Reports menu on the Resident screen, click Ledger. 
 

Ledger 



 
 
 

5 Review the household’s resident ledger. When you are finished, close the ledger screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 From the Reports menu on the Resident screen, click Unpaid Charges. 
 
7 Review the unpaid charges ledger. When you are finished, close the unpaid charges ledger screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A resident’s ledger contains paid and unpaid charges and receipts for paid charges. The unpaid charges ledger 
contains only unpaid charges. Because you have just completed the move in, both ledgers will look the same and 
show only the transactions posted for the move-in. 
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This lesson explains how to use the Voyager affordable housing waiting list for a HUD project-based 
property. 
 
 

Introduction to LIHTC Waiting Lists 
 
Waiting lists in Voyager are set up by property. Each property has only one waiting list, organized by 
bedroom size defined as the number of bedrooms in a unit. You will be able to quickly see how many 
households are waiting of each bedroom size in the property. 
 
Voyager keeps a contact history for each household and requires contact-log documentation for wait-
ing list actions and events that affect a household’s position on the list. Examples are moving a house-
hold to the bottom of the list or removing a household from the list. You can also add information to 
the contact-log as needed. You can review a household’s contact history and print an affordable hous-
ing waiting list report that shows each household’s position on the list at a specific point in time. 



 
 
 

In this lesson, you will learn how to complete the following tasks: 
 

• Add prospects to a a property’s waiting list. 

• Document contact events for households on waiting lists. 

• Review household waiting list information. 

• Generate a waiting list report. 

• Move households to the bottom of a waiting list 

• Remove households from a waiting list 

• Add residents to a property’s waiting list. 

 
 

Voyager helps you to quickly complete Voyager screens. For fields that you can complete by typing, typing the first few 
characters automatically displays a selection list based on information that you previously used in that field. You can 
either select from the displayed list or complete the field by continuing to type. 

 
 

Adding Prospects to LIHTC Waiting Lists 
 
LIHTC properties may be frequently fully-occupied. When no units are available, a waiting list is set up 
for the property, and your security permissions give you access the waiting list, you can add prospects 
to the waiting list. If you have access to waiting lists for several properties, you can also include the 
prospect on those lists. 
 

In this lesson, you will add a prospect to a waiting list from the Preferences leasing step. You can also add the prospect 
to the property’s waiting from any leasing step of the leasing workflow. 



 
 
 

To add a prospect to an LIHTC property’s waiting list 
 
1 Add a prospect guest card for the household head and then click Next to advance to the Prefer-
ences leasing step. 

 

2 Click the Waiting List button, located above the Preferences tab on the Prospect Guest Card 
screen. 

 
 
 
 
 
 
 
 

Waiting List 
button 

 
 
 
 
 
 
 
 
 
 

TheWaiting List screen appears. The Contact Log tab appears in the bottom part of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact Log tab 



 
 
 

3 Complete the following fields in the top part of the Waiting List screen: 
 
 

First Choice 
 

Second Choice 
 
 

Third Choice 
 
 

Household Size 
 

Comments 

Select the unit size, in terms of the number of bedrooms, that the prospect prefers. 
 
If units of more one size exist in the property and the prospect has a second choice for number 
of bedrooms, select the prospect’s second choice. 
 
If units of several sizes exist in the property and the prospect has a third choice for number of 
bedrooms, select the prospect’s third choice. 
 
Type the number of people in the household. 
 
Type initial remarks, if needed. 
 

NOTE Ensure that your comments, notes, and remarks comply with fair housing laws. Follow 
direction of management in your organization before adding comments. 

 
 

4 On the Contact Log tab, complete the following fields: 
 
 

Contact Date 
 
 

Contact Time 
 
 

Type of Contact 
 

Comments 

Type the date on which you are adding the prospect to the waiting list, or click the Calendar 
button and select the date. 
 
Type the at which you are adding the prospect to the waiting list, or click the Clock button 
and select the time. 
 
Select New Application. 
 
Type notes or remarks, if needed. 
 

NOTE Ensure that your comments, notes, and remarks comply with fair housing laws. Follow 
direction of management in your organization before adding comments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Application 



 
 
 

5 Click the Tax Credit tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tax Credit tab 
 
 
 
 
 

6 In the Estimated Percent of AMGI field, type the percentage of the area median gross income that 
you estimate is appropriate for the household. 

 

7 If a Special Needs field appears on the Tax Credit tab and the household has one of the special 
needs included on the selection list, select the most appropriate special needs type. 

 
The two-character state code recorded on the Property screen for the subject property determines the special 
needs that appear on this list. 

 
 

8 Click the Demographics tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Demographics tab 



 
 
 

9 Complete the following fields: 
 
 

Gender 
 
 
 
 

Ethnicity 
 
 
 
 

Race 

SelectMale or Female. 
 

If you are not required to specify gender for your waiting list and the person does not want to 
identify with a specific gender, select Declined to Report. 
 
Select the 1-Hispanic or 2-Non-Hispanic. 
 

If you are not required to specify ethnicity for your waiting list and the person does not want to 
disclose whether the person is Hispanic or non-Hispanic, select Declined to Report. 
 
Select all that apply. 
 

If you are not required to specify race for your waiting list and the person does not want to 
disclose racial background, select Declined to Report. 

 
 

10 If your waiting list is set up with preferences, a Preferences tab appears. Click the Preferences tab, 
and select any preferences that apply to the household. 

 
Preferences influence the order in which a household appears on a waiting list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Preferences tab 
 
 
 
 
 

Selected 
preference 

 
 
 
 

11When you have added all of the information that your management organization requires, click 
Save and then close the Waiting List screen. 

 
You have added the prospect to the waiting list. 



 
 
 

Documenting Waiting List Contact Events 
 
Voyager keeps a contact-log for each household on a waiting list. You should document every contact 
event that occurs with a household on a waiting list. 
 

Depending on your user security permissions, you will manually add information to the contact log when you need to 
move a household to the bottom of a waiting list, remove a household from a waiting list, or document other waiting 
list contacts and events. When you complete procedures such as approving a prospect’s application during the leasing 
process or processing a move-in, Voyager automatically updates the household’s contact log. 

 
 
To document a waiting list contact event for a prospect 
 
1 On the Community Manager Dashboard screen, perform a person search to find the name of the 

household head. The name appears on the Person Search tab. 
 

2 Click the name of the household head. The Prospect Guest Card screen appears. The selected leas-
ing step on the guest card is the last step that you completed. 

 

3 Click the Waiting List button. The Waiting List screen appears. The Contact Log tab appears in the 
bottom part of the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Contact Log tab 



 
 
 

4 On the Contact Log tab, complete the following fields: 
 
 

Contact Date 
 

Contact Time 
 

Type of Contact 
 
 

Comments 

Type or select the date on which the contact occurred. 
 
Type or select the contact time. 
 
Select the type of contact or event that you are recording. For example, if you are recording a 
contact for a phone conversation, select Update or Active. 
 
Type notes or remarks, if needed. 
 

NOTE Ensure that your comment comply with fair housing laws. Follow direction of 
management in your organization before adding comments 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type of contact 



 
 
 

5 Click the Save button. Voyager adds the information to the prospect’s contact log. A row appears at 
the top of the prospect’s contact history. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Most recent contact 
 
 
 
 

Reviewing Prospect Waiting List Information 
 
You can review a prospect’s waiting list information from the any leasing step on the Prospect Guest 
Card screen. While reviewing the information, you can add additional information or document addi-
tional contacts. 
 
 

To review a prospect’s waiting list information 
 
1 Perform a person search to find the household head and then click that person’s name. The Pros-
pect Guest Card screen appears. The selected leasing step on the guest card is the last step that 
you completed for the household. 

 
2 Click the Waiting List button. The Waiting List screen appears. 
 
3 Review the information on the screen. If needed, add additional comments or document a new 

contact event. 
 

4 When you are finished, close the Waiting List screen. 



 
 
 

Reviewing LIHTC Property Waiting Lists 
 
In the Traffic section on the Community Manager Dashboard screen, the number to the right of the 
Affordable Waiting List heading represents the waiting list for the selected property. Voyager sorts 
an affordable housing waiting list by bedroom size, defined as the number of bedrooms in the unit. 
Voyager shows a separate view of the list by bedroom size. 
 
For example: 
 
! If a waiting list includes only households requesting one-bedroom units, or if a waiting list includes 

only households requesting two-bedroom units, the number 1 appears to the right of the heading. 
Clicking the number displays the Affordable Waiting Lists tab with one waiting list. 

 
! If a waiting list includes households requesting two-bedroom units and households requesting 

three-bedroom units, or if a waiting list includes households requesting one-bedroom units and 
three-bedroom units, the number 2 appears to the right of the heading. Clicking the number dis-
plays the Affordable Waiting Lists tab with two waiting lists, one for each bedroom size that the 
households on the list have requested. 

 
When a waiting list is set up for the subject property, a 0 (zero) appears for the Affordable Waiting Lists heading 
in the Traffic section of the Community Manager Dashboard screen until you have added households to the 
waiting list. 



 

     

     
Number of people on each list 
 

 
 
 

The Number on List column on the Affordable Waiting Lists tab represents the number of house-
holds on each waiting list. Clicking the number displays that waiting list in a format similar to the 
affordable housing waiting list report. 
 
The following graphic shows the Community Manager Dashboard screen. The affordable housing 
waiting list for the subject property is sorted by bedroom size. In this example, the list has two house-
holds waiting for a one-bedroom unit and four households waiting for a two-bedroom unit. 
 
 
 
 
 
 
 
 
 
 
 
 

List by number of 
bedroom sizes 

 
 
 
 
 
 
 
 
 
 
 
 
 

Waiting list sorted by bedroom size 



 
 
 

To review an LIHTC property waiting list 
 
1 On the Community Manager Dashboard screen, select a property. 
 
2 In the Traffic section of the dashboard, click the number for Affordable Waiting Lists. 
 

The Affordable Waiting List tab appears in the bottom part of the screen, sorted by the number of 
bedrooms that the households on the list have requested. A row appears for each number of 
bedrooms (bedroom sizes) requested. In each row, the Number on List field displays the number of 
households on the waiting list for that bedroom size. The numbers are links to the waiting list details. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Two-bedroom waiting list Number of people on the two-bedroom waiting list 



 
 
 

3 On the row for the list that you want to review, click the number in the Number on List field. The 
Waiting List Details tab appears in the bottom part of the screen. 

 

• If the household is a prospect, each name and address is a link to the Prospect Guest 
Card screen. 

 

• If the household is a resident, each name and address is a link to the Resident screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 When you are finished reviewing the waiting list, click the Home button on the Voyager top menu 
to close the Affordable Waiting List tab. 



 
 
 

Generating LIHTC Property Waiting List Reports 
 
The affordable housing waiting list report shows the order in which households appear on a property’s 
waiting list. After displaying the report, you can save or print it either as a Microsoft Excel or Adobe PDF 
file. 
 
 

To generate a waiting list report for an LIHTC property 
 
1 From the side menu, select Analytics > Compliance Reports. The filter section of the Compliance 

Reports screen appears. 
 
 
 
 
 
 
 
 
 
 
2 Complete the following fields, as needed: 
 
 

Report Type 
 

Property 
 
 

Bedroom Size 
 

Effective Date 
 
 

Show ‘On List’ 
 
 

Show ‘Removed’ 
 
 
 

Show ‘Moved In’ 
 
 

Show Grid 

Select Waiting List. 
 
The code of the property selected on the Community Manager Dashboard screen appears. 
If needed, type or select a different property code. 
 
Select the number of bedrooms for which you want to produce the list. 
 
Type or select the starting date for the report. The report will include all households added to 
the list on or after your selected date. 
 
If you want to include households on the waiting list as of your selected effective date, select 
Yes. If you want to exclude people who were on the list, select No/ 
 
If you want to include households that have been removed from the waiting list as of your 
selected effective date, select Yes. If you want to exclude people who were on the list, select 
No/ 
 
If you want to include households that had moved in as of your selected effective date, select 
Yes. If you want to exclude people who were on the list, select No/ 
 
If you want to display column-separator lines on the report, select this check box. 



 
 
 

3 Click Display. The report appears in the bottom part of the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Unless the waiting list has preferences set up and preferences are selected for some of the 
households, households on an LIHTC waiting list have priority by date and time. 

 

4 If you want to print or save the report, take one of the following steps: 
 

! If you want to save or print the report as a Microsoft Excel file, click the Excel button. 
 

! If you want to save or print the report as an Adobe PDF file, click the PDF button. 
 
 

Moving Households to the Bottom of an LIHTC Property Waiting List 
 
When you need to move a household to the bottom of a waiting list, you must document the event in 
the household's waiting list contact log. Adding a contact log event of the type Move to Bottom of 
WL automatically resets the date and time at which the household was added to the list. 
 

If an Additional Properties tab appears on the Waiting List screen and additional properties are selected for the 
household, moving the household to the bottom of the waiting list for the subject property also moves the household 
to the bottom of the lists for the selected additional properties. If you added the household manually to the waiting 
lists of several properties, moving the household to the bottom of the waiting list for one property does not 
automatically move the household to the bottom of the other waiting lists. 

 

Carefully follow the policies of your management organization when moving a household to the bottom of a waiting 
list. Clearly document the time, date, and reason. Always ensure that comments, notes, or remarks comply with fair 
housing laws. If you keep the waiting list electronically, print the waiting list or preserve backup copies that show how 
the waiting list appeared before and after you changed a household’s position on the list. 



 
 
 

To move a household to the bottom of an LIHTC property’s waiting list 
 
1 Open the Waiting List screen for the household that you are moving to the bottom of the list. 
 
2 On the Contact Log tab, complete the following fields: 
 
 

Contact Date 
 

Contact Time 
 

Type of Contact 
 

Comments 

Type or select the date on which you moved the household to the bottom of the waiting list. 
 
Type or select the time on which you moved the household to the bottom of the waiting list. 
 
SelectMove to Bottom of WL. 
 
Type or select notes or remarks, if needed. 
 

NOTE Ensure that your comments, notes, or remarks comply with fair housing laws. Follow 
direction of management in your organization before adding comments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact 
type 



 
 
 

3 Click Save. 
 

Voyager saves the information and adds a row to the log. The household is now at the bottom of the 
waiting list as of your selected date and time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Waiting list contact type Waiting list status 



 
 
 

Rejecting Waiting List Applicants 
 
Negative responses from references, the results of a criminal background check, or other reasons cause 
the need for rejecting an applicant from a waiting list. If you need to reject an applicant, clearly docu-
ment the date, time, and reason for the rejection. 
 
 

To reject an applicant on a property’s waiting list 
 
1 On the Community Manager Dashboard screen, select the property. 
 
2 Open the Waiting List screen for the household that you rejecting from the waiting list. 
 
3 On the Contact Log tab, complete following fields: 
 
 

Contact Date 
 

Contact Time 
 

Type of Contact 
 
 
 

Rejection Reason 

Date on which you are rejecting the applicant from the waiting list 
 
Time at which you are rejecting the applicant from the waiting list 
 
Type of contact that you are recording 
 

Select Application Rejected. 
 
Reason that you are rejecting the applicant from the waiting list 
 

Type or select the reason for the rejection 
 

NOTE If you are manually typing the reason, ensure that your comments, notes, and remarks 
comply with fair housing laws. Follow direction of management in your organization before 
adding comments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Type of contact Reason for rejection 



 
 
 

4 Click Add to Contact Log. You have rejected the applicant. Voyager updates the applicant’s contact 
log. The household is no longer on the waiting list. 

 
If a rejected applicant wins an appeal for the denial and then re-applies, Voyager adds the applicant to the waiting 
list in the applicant’s original position. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Waiting list status 
 
 

Denying Waiting List Applicants Assigned to Units 
 
When you deny a prospect household that is on a waiting list, Voyager automatically removes that 
household from the property’s waiting list. You do not need to manually process the removal. 
 

The following example describes the process of denying a prospect household that is on an LIHTC 
property’s waiting list after the household has been assigned to a unit. The Light household will be our 
example. 
 

Household at the top of the waiting list 



 
 
 

This household is on the Applicant Status Leasing step in the leasing workflow process. The follow-
ing graphic shows the Application Status leasing step for the Light household. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Clicking the Deny button opens the Deny Application screen. You must select the denial date and 
time, the property agent, and the reason for denial. You can also type comments or remarks for the 
household’s waiting list contact log. Clicking Save completes the denial process. 
 
The following graphic shows the Deny Application screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Always ensure that waiting list comments, notes, or remarks comply with fair housing laws. Follow direction of 
management in your organization before adding comments. 



 
 
 

The following graphic shows the waiting list after the Light household was denied. The denial auto-
matically removed the household from the property’s waiting list. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Removing New Residents from Additional Properties Waiting Lists 
 
When a prospect household is on a property’s waiting list, completing a move-in removes the house-
hold from that waiting list. If the new resident was assigned to additional properties from the subject 
property’s waiting list, completing the move-in removes the resident from the waiting lists for those 
additional properties. 
 
If you have assigned a household to waiting lists for other properties by manually adding the house-
hold to those waiting lists, processing the move-in does not automatically remove the household from 
those waiting lists. If the resident household no longer wants to remain on those lists, you must manu-
ally remove the household. Other circumstances may also result in the need to remove a resident from a 
waiting list. The following steps describe how to manually remove a resident household from a prop-
erty’s waiting list. 
 

When you remove a household from a waiting list, clearly document the reasons and the time and date of that action. 
If you keep waiting lists electronically, periodically print the waiting list or preserve backup copies, showing how the 
waiting list appeared before and after you removed the household from the list. 

 

Carefully follow the policies of your management organization when removing a household from a waiting list. Clearly 
document the time, date, and reason. Always ensure that comments, notes and remarks comply with fair housing laws. 



 
 
 

To remove a resident household from a property’s waiting list 
 
1 Open the Resident screen for the household that you want to remove from the waiting list. 
 
2 From the Data menu on the Resident screen, click the Affordable Waiting List link. 
 

Affordable Waiting List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TheWaiting List screen appears. 
 
3 On the Contact Log tab, complete the following fields: 
 
 

Contact Date 
 

Contact Time 
 

Type of Contact 
 

Comments 

Type or select the date on which you are removing the resident from the waiting list 
 
Select the time at which you are removing the resident from the waiting list 
 
Select Removed. 
 
Type remarks or comments, if needed. 
 

NOTE Ensure that your comments, notes, and remarks comply with fair housing laws. Follow 
direction of management in your organization when adding comments. 

 
 

4 Click Save. 
 

Voyager saves the information and adds a line to the contact log. The resident’s waiting list status is 
now Removed. 



 
 
 

Adding Residents to LIHTC Property Waiting Lists 
 
When a change in a resident household’s size or circumstances cause a need for a different unit and no 
units meeting the household’s needs are available, you can add the household to the property’s wait-
ing list. 
 
 

To add a resident household to an LIHTC property’s waiting list 
 
1 On the Community Manager Dashboard screen, perform a person search to find the household 

head. 
 
2 On the Person Search tab, click the name of the household head. The Resident screen appears. 
 

Affordable Waiting List 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Click the Affordable Waiting List link. The Waiting List screen appears. 



 
 
 

4 Complete the Contact Log and Tax Credit tabs as you did when you added a prospect to the wait-
ing list at the beginning of this lesson. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5 When you are finished, click Save and then close the Waiting List screen. 
 
 

To document a waiting list contact event for a resident 
 
1 From the Data menu on the Resident screen, click the Affordable Waiting List link. The Waiting 

List screen appears. 
 
2 Complete and save the contact information. When you are finished, close the Waiting List screen. 
 
 

To review the waiting list information for a resident 
 
1 From the Data menu on the Resident screen, click the Affordable Waiting List link. The Waiting 

List screen appears. 
 

2 Review the information. If you make any changes, click Save and then close the Waiting List 
screen. 

 
 

Removing Households from LIHTC Property Waiting Lists 
 
Circumstances occur in which you need to remove a household from a waiting list. For example, a 
prospect household may not respond to a request for an eligibility interview or may find a preferred 
unit in another property, or a resident household waiting for a unit transfer may decide to withdraw 
the transfer request. 



 
 
 

Documenting a contact event of the contact type Removed removes a household from a waiting list. 
After you have completed and saved the information, the household’s waiting list status automatically 
changes to Removed. 
 

If an Additional Properties tab appears in the Waiting List screen and additional properties are selected for a 
household, removing the household from the waiting list of the subject property also removes the household from the 
lists for those additional properties. If you added the prospect manually to waiting lists for several properties, removing 
the prospect from the waiting list of one property does not automatically remove the prospect from the waiting lists 
of the other properties. 

 

Carefully follow the policies of your management organization when removing a household from a waiting list. Clearly 
document the time, date, and reason. Always ensure that comments, notes or remarks comply with fair housing laws. 

 
 
To remove a household from an LIHTC property’s waiting list 
 
1 Open the Waiting List screen for the household that you want to remove from the list. 
 
2 On the Contact Log tab, complete the following fields: 
 
 

Contact Date 
 

Contact Time 
 

Type of Contact 
 

Comments 

Type or select the date on which you are removing the household from the waiting list 
 
Select the time at which you are removing the household from the waiting list 
 
Select Removed. 
 
Type notes or remarks, if needed. 
 

NOTE Ensure that your comments, notes, and remarks comply with fair housing laws. Follow 
direction of management in your organization before adding comments. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Contact type 



 
 
 

3 Click Save. 
 

Voyager saves the information and adds a line to the contact log. The household’s waiting list status 
is now Removed. 

 
 
 
 
 
 
 
 

 
 
 
 

 
Waiting list contact type Waiting list status 
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LIHTC Household Move-Outs 
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This lesson explains how to record a move-out notice for an LIHTC household. 
 
 

Introduction to LIHTC Move-Out  
In Voyager, the move-out process consists of three steps: 
 

1 Placing a household on notice for move-out 
 

2 Recording the move-out 
 

3 Completing deposit accounting for the household after move-out 
 
In this lesson you will complete the first of these steps, recording the move-out notice. You will also 
learn how to cancel the notice when a household on notice decides not to move out. 
 

For this lesson, you will need to find or create a current resident household for which you can process a 
move-out. In the examples used in this lesson, the household has only a move-in certification and has 
lived in the unit for five months. The household has only one lease charge, a lease charge for rent. The 
household will receive a refund after move-out. 
 

Voyager helps you to quickly complete Voyager screens. For fields that you can complete by typing, typing the first few 
characters automatically displays a selection list based on information that you previously used in that field. You can 
either select from the displayed list or complete the field by continuing to type. 



 
 

The following graphic shows the Resident screen and ledger for the household used in this lesson. The 
status of this resident is Current. Rent has been paid through January, 2014, and the resident’s bal-ance 
is $0.00 (zero). 
 
 
 
 
 
 
 
 

Resident status 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Ledger balance 
 
 

In the examples that follow, the household is giving notice on December 9 and plans to move out on 
January 12. 



 
 

Recording a Move-Out Notice for an LIHTC Household 
 
Recording a move-out notice for a resident documents a pending move-out and adds the notice date 
and pending move-out date on the Resident screen. The household’s status changes to a notice sta-
tus. The household’s unit becomes available for selection by new prospects who plan to move in after 
the current household’s move-out date. 
 
 

To record a household’s move-out notice 
 
1 Open the Resident screen for the household that will be moving out. 
 
a On the Community Manager Dashboard screen, click the Person Search tab. The Person 

Search tab appears in the bottom part of the dashboard. 
 

b In theName field, type the first or last name of the household head and then click the Search but-
ton. A list of people who match your selection criteria appears. 

 

c Click the name of the household head. 
 

Name of household head 



 
 

The Resident screen appears. 
 
2 From the Functions menu on the Resident screen, click Notice. 
 

Notice 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The Affordable Notice screen appears. 



 
 

3 Complete the screen as follows: 
 

Termination Type Select the type of move-out. 
 

Notice Date Type or select the date that the household is providing notice. 
 

Move Out Date Type or select the date that the household is moving out. 
 

Reason for Move Out Select the reason that the household is moving out. 



 
 

4 Click Save. The Resident screen appears. A message appears in the top part of the screen: Notice 
has been posted. 

 
The resident’s status is now Notice. Voyager records the anticipated move-out date on the Lease Info 
tab of the Resident screen. 

 
Notice message 

 
 
 
 
 
 
 

Resident status 
 
 
 
 
 
 
 
 

Lease Info tab 
 
 
 
 
 
 
 
 
 
 
 

Move-out date 
 
5 When you have finished reviewing the Resident screen, click the Home button on the top menu. 

The Resident screen closes. 



 
 
 
 

Canceling Move-Out Notices 
 
If a household on notice decides not to move out, you can cancel the notice. When you cancel a move-
out notice, the household’s status again becomes Current. 
 
 

To cancel a household’s move-out notice 
 
1 On the Community Manager Dashboard screen, select the property in which the household lives. 
 

TheOn Notice total in the Resident Activity section shows the number of households on notice for 
move-out. 

 

2 Click the number to the right of the On Notice heading. The On Notice tab appears in the bottom 
part of the dashboard, displaying a summary of households on notice. 

 
Number of households on Notice 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Cancel Notice 
 

Information on the On Notice tab includes the move-out date, unit, and the name of the household 
head. The unit and name of the household head are links to their Unit and Resident screens. The 
Status field identifies whether a household is on notice or schedule for eviction. Buttons for adjusting 
the move-out date, canceling the move-out, and canceling the eviction appear to the right of the 
Status field. For a resident on notice, the Cancel Evict button is dimmed. 



 
 
 

3 On the row displaying the household for which you want to cancel the notice, click the Cancel 
Notice button . 

 
The Resident screen appears. You have canceled the notice. A message appears in the top part of the 
screen: Notice has been canceled. The resident’s status is now Current. Voyager has removed the 
anticipated move-out date on the Lease Info tab of the Resident screen. 

 
 

Notice message 
 
 
 
 
 
 
 

Resident status 
 
 
 
 
 
 
 

Lease Info tab 
 
 
 
 
 
 
 
 
 
 
 

Move-out date 
 
4 When you are finished reviewing the Resident screen, click Save. 
 
5 Click the Home button on the top menu. The Resident screen closes and the Community Man-
ager Dashboard screen appears. The Move Out total has decreased by one. 

 



 
 
 

 
 

Evictions 
 
Request for a Termination Letter 
 
Site Management Role: 

• Verbal warnings and mediation are strongly encouraged – Record any verbal mediation in Manager’s Log 
• Violation letter #1:      Friendly reminder 
• Violation letter # 2:    More assertive notice 
• Violation letter # 3:    Final attempt to resolve 
 

Site Employee Resource Center Role: 
• Final termination (Eviction) letters only 

 
Should I Request an Termination Letter? 

Consider the questions below prior to requesting an termination letter: 
• Is there a clear lease violation? 
• Have you personally intervened? 
• Have written warnings been served?  How many? 
• Has there been adequate time to remedy? 
• Does the punishment fit the violation? 

Requesting a Termination Letter 
To request a termination letter, complete a Request for Termination (Continuing Non-Compliance) form 
(#C059) from Tenant Technologies website and fax to the Site Employee Resource Center. 
 

 
 
Delivering a Termination Letter 
Site Management Responsibilities: 

• Post / personally serve the violation letter on the same day that the letter is dated 
• Do not distribute internal paperwork (i.e. “Request for Termination”) 
• Complete proof of service; fax to the Site Employee Resource Center 
• Do not mail the violation Letter – it will be mailed from the Site Employee Resource Center 

Site Employee Resource Center Responsibilities: 
• Email letter to site for posting / personal service 
• Mail letter to resident via United States Postal Service 



 
 
 

Documenting an Eviction 
 

When you need to evict a resident from the property, you document the eviction in Voyager. Evictions work just like 
notices, except that the property usually determines the move-out date for an eviction— not the resident. 

 
 
To document an eviction:  

1   Using the Person Search tab on the dashboard, locate the appropriate resident and click the name link to open 

the Resident screen. For more information, see “Searching for Guests and Residents” on page 66. 
 
 
 
 
 
 
 
 
 

Evict 
 

2   In the Resident screen, click Notice in the Functions menu. The Notice screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the following fields: Evict Date, Move-Out Date, and Reason for Move-Out. 
4   If you want to post a termination fee, select Post Early Termination Fee. 

 
 



 
 
Canceling Evictions 

 
 

To cancel an eviction 
 

1   On the dashboard, in the Resident Activity section, select the On Notice link. The bottom part of the screen 

displays a list of the residents currently evicted. 
 

On Notice link 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cancel Evict button 
 

2   Locate the appropriate resident. 
 

3   Click the Cancel Evict button. 
 

Voyager returns the resident’s status to Current.  The On Notice count on the dashboard is reduced by one. If the 
resident’s lease will expire within 120 days (or has already expired), the Expiring Leases count is increased by one. 

 
 
 

If the unit has already been rented to someone else, the system will not let you cancel the eviction until 
you assign another unit to the new resident 
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This lesson explains how to record a move-out for an LIHTC household. 
 
 

Introduction to LIHTC Move-Out 
In Voyager, the move-out process consists of three steps: 
 

1 Placing a household on notice for move-out 
 

2 Recording the move-out 
 

3 Completing deposit accounting for the household after move-out 
 
In the previous lesson, you learned how to record a move-out notice and cancel a move-out notice. In 
this lesson, you will learn how complete the second step in the move-out process: recording the move-
out. 
 

The examples in this lesson use the household from the previous lesson. Rent has been posted and 
paid for the month of April. The household has a ledger balance of zero. The household has again 
decided to move out on April 23. The household is on notice for a move-out date of April 23. 
 
So that you can actively follow this lesson, place a household on notice before beginning the lesson. 



 
 
 

Adjusting Move-Out Dates for Households on Notice 
 
Although many households move out on their scheduled move-out dates, occasions occur in which 
the move-out is either delayed or moved forward. When you adjust a household’s move-out date, Voy-
ager automatically adjusts the move-out date on the Lease Info tab of the Resident screen. 
 
In our example, the household is on notice and needs to adjust the move-out date from February 12 to 
February 11. 
 
 

To adjust the move-out date for a household on notice 
 
1 On the Community Manager Dashboard screen, select the property in which the household lives. 
 
2 Click the number to the right of the On Notice heading. The On Notice tab appears in the bottom 

part of the dashboard. 
 

Number of households on Notice 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Adjust Dates 
 

Information on the On Notice tab includes the move-out date, unit, and the name of the household 
head. The unit and name of the household head are links to the Unit and Resident screens. The 
Status field identifies whether a household is on notice or schedule for eviction. Buttons for adjusting 
the move-out date, canceling the move-out, and canceling the eviction appear to the right of the of 
the Status field. For a resident on notice, the Cancel Evict button is dimmed. 



 
 
 

3 On the row displaying the resident for which you are adjusting the move-out date, click the Adjust 
Dates button . The Affordable Notice screen appears. 

 
 
 
 
 
 
 
 
 
 
 

Move Out Date 
 
 
 
 
 
 
4 In theMove Out Date field, type the date that the household now wants to move out. 
 
5 Click Save. Voyager adjusts the move-out date. The Resident screen appears. A message in the top 

part of the screen confirms that the date is now adjusted. The new move-out date appears in the 
Move Out date field on the Lease Info tab. 

 
Move-out date adjustment message 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lease Info tab 
 
 
 
 
 
 
 
 
 
 

Move-out date 



 
 
 

Moving Out LIHTC Households 
 
A move-out ends the residential cycle for the household moving out. When you process a move-out, 
the household becomes a past resident of the property and unit. The unit becomes available for 
another household as of the move-out date plus the days that you have set up to make the unit ready 
for occupancy. 
 
Processing a move-out posts move-out charges for the household. For LIHTC residents, Voyager posts 
rent charges due at move-out based on the accounts receivable of the project. You can open the Resi-
dent screen and review the resident’s ledgers. 
 
 

To process a move out for an LIHTC household 
 
1 On the Community Manager Dashboard screen, select the property in which the household lives. 
 

In the Resident Activity section of the dashboard, you see the total number of households ready for 
move-out. 

 
2 Click the number to the right of the Move Out heading. TheMove Out tab appears in the bottom 

part of the dashboard, displaying a summary of residents ready for move-out. 
 

Number of households scheduled for move-out 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move Out button 
 
 

Information on the Move Out tab includes the move-out date, unit, and the name of the household 
head. The unit and name of the household head are links to the Unit and Resident screens. Buttons 
for completing the move-out, adjusting the move-out date, and canceling the notice appear to the 
right of the Resident field. 



 
 
 

3 On the row displaying the household that you are moving out, click the Move Out button . A 
confirmation message appears. Click OK. Voyager posts the move-out. On the Community Man-
ager Dashboard, the Move Out number has decreased by one. 

 
The Resident screen appears. Processing a move-out updates the household’s resident status from 
Notice to Past. 

 
 
 
 
 
 
 
 

Resident status 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 When you are finished reviewing the Resident screen, click the Home button on the top menu. The 
Resident screen closes and the Community Manager Dashboard screen appears. 
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This lesson describes how to complete accounting transactions for past residents after move-out. 
 
 

Introduction to LIHTC Move-Out Deposit Accounting 
In Voyager, the move-out process consists of three steps: 
 

1 Placing a household on notice for move-out 
 

2 Recording the move-out 
 

3 Completing deposit accounting for the household after move-out 
 
In the previous lesson, you learned how to record a move-out for a household on notice. You are ready 
for the last step in the move-out process, completing deposit accounting for the household that has 
moved out. 
 

In the examples used for this lesson, the household has moved out with no unpaid charges at move-
out. 
 

Deposit accounting posts transactions as of the day that you post it. You cannot save deposit accounting that you have 
partially completed. 



 
 
 

Completing Move-Out Deposit Accounting for Past Residents 
 
Deposit accounting reconciles outstanding charges and credits for a household that has moved out. 
Deposit accounting transactions include deposit refunds, move-out charges and other applicable 
charges. 
 
c If the reconciliation results in a refund due posting deposit accounting automatically creates a 

refund transaction payable to the resident. 
 

c If the reconciliation results in an outstanding balance, posting deposit accounting adjusts the resi-
dent’s ledger for that balance due. 

 
Completing deposit accounting is a single procedure. You cannot save deposit accounting that you have partially 
completed. 

 
 
 

To complete move out deposit accounting for a past resident 
 
1 On the Community Manager Dashboard screen, click the number to the right of the Deposit 
Accounting heading. The Deposit Accounting tab appears in the bottom part of the dashboard. 

 
Number of past resident households ready for deposit accounting 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Deposit Accounting button 



 
 
 

Information on the Deposit Accounting tab includes the move-out date, unit, and the name of the 
household head. The unit and name of the household head are links to the Unit and Resident 
screens. A Deposit Accounting button appears to the right of the Resident field. 

 
The deposit accounting summary may also include the names of applicants who did not proceed with a move-in. 
For an applicant, a Clear Applicant button appears. 

 
 
2 On the row displaying the resident for which you want to complete deposit accounting, click the 
Deposit Acctg button . 

 

The Deposit Accounting screen appears. Information about the resident appears in the part of the 
screen. The resident’s code, the property code, and the unit code are links that you can click to review 
those screens. The Forwarding Address section appears below the resident’s current information. 

 
An itemized list of outstanding charges and credits appears in the bottom part of the screen. The total 
refund due or the total net amount owed appears at the bottom of the list. 

 

• If a charge is required, a check mark appears in the check box and that box is dimmed. 
 

• If a charge is optional, the check box is clear. You can select the charge to include it as part 
of deposit accounting. 

 

• If a required or optional charge is modifiable, you can change the amount of the charge. 
 

The following graphic shows the Deposit Accounting screen. This example shows a required rent 
credit, a required rent charge, and two optional charges. Both optional charge amounts are 
modifiable. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Required credits and 
charges 

 

Optional modifiable 
charge 

 
 
 
 
 

Print Statement 



 
 
 

3 If you know the household’s forwarding address, complete the Forwarding Address section that 
appears above the charge description. 

 
4 If an item for an optional charge appears and you want to add a charge for that item, select the 

item. If the amount is modifiable and you want to change it, type the amount over the displayed 
amount. As you select items and modify amounts, Voyager adjusts the totals and the refund or bal-
ance due. 

 
The following graphic shows an example of the Deposit Accounting screen completed and ready to 
post. In this example, the user has selected an optional cleaning charge. The household has a $595.16 
refund due. 

 
 
 
 
 
 
 
 
 
 

Forwarding address 
 
 
 
 
 
 

Selected optional charge 
 
 
 
 
 
 

Net refund amount due 



 
 
 

5 If you want to print the deposit accounting statement, select the Print Statement check box. 
 
6 When you have reviewed the charges and are ready to post, click the Post button. Voyager posts 

the household’s deposit accounting. 
 
c If you selected the Print Statement check box, the statement appears. 

Save statement button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a Click the Save Statement button   that appears above the statement. 
 
b Save the statement as a PDF, MS Word, or Excel file. You can print the saved statement. 

 
c If you did not select the Print Statement check box on the Deposit Accounting screen, the Resi-
dent screen appears. A message appears in the top part of the Resident screen confirming that 
deposit accounting has been posted. 

 

7 When you are finished, click the Home button on the top menu. The screen displaying the state-
ment closes and the Community Manager Dashboard screen appears. 



 
 

Processing Deposit Accounting Paperwork 

1. Print three copies of the Move Out Statement – one for the resident, one to be mailed to Site  
Employee Resource Center and one for site management records. 

2. Assemble all paperwork according to the Move-Out Envelope (available to order from B&B Print 
Source). Assemble all paperwork from the resident(s) file in the order listed on the move-out 
envelope. Do not seal the envelope. 

3. If the resident owes a balance, the Resident copy of the Move Out Statement is mailed directly 
from the site office to the Resident.  All other paperwork is placed in Move-Out Envelope and 
mailed to Site Employee Resource Center. 

 
 



 
 
 

Reviewing Resident Ledgers for Past Residents 
 
Posting move-out deposit accounting adds charges to the household’s ledgers. Voyager provides a 
complete ledger, an unpaid charges ledger, and a pending payments ledger so that you can select the 
ledger appropriate for the transactions that you want to review. 
 
In the example used in this lesson, the household had a credit balance at move-out. We will review 
only the household’s complete resident ledger and the last transaction that appears on that ledger. 
 
 

To review a past resident’s ledger after completing deposit accounting 
 
1 Open the Resident screen for the past resident household. 
 
a On the Community Manager Dashboard screen, click the Person Search tab. The Person 

Search tab appears in the bottom part of the dashboard. 
 

b In theName field, type the first or last name of the household head and then click the Search but-
ton. A list of people who match your selection criteria appears. 

 

c Click the name of the household head for the past resident household. The Resident screen 
appears. The household’s rental status is Past. 

 
 
 
 
 
 
 
 

Resident status 



 
 
 

2 From the Reports menu, select Ledger. The resident’s complete ledger appears. 
 

The following graphic shows the ledger for the household that we have used in our examples. 
Deposit accounting for this household resulted in a refund of $595.16. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Control number 
 
 
 

Refund due 



 
 
 

a Click the transaction control number. The Charge Invoice screen appears. 
 

The following graphic shows the Charge Invoice screen for the household’s refund transaction. 
The Reference field shows that this charge is for a refund. Because the charge is for a refund, it is 
fully paid by a zero-dollar receipt. 

 
Reference 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Description 
 
 

b Click the Payment Details tab. A link to the zero-dollar receipt appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Receipt control number 



 
 
 
 

c The control number for the receipt. The Receipt screen appears. 
 

The following graphic shows the Receipt screen for zero-dollar receipt R-7938, the Voyager 
control number of the receipt shown in the previous graphic. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3 When you have finished reviewing the transactions, close the transaction screens. The Resident 

screen appears. 
 

4 If your deposit accounting for your household resulted in unpaid charges at move-out, display the 
Unpaid Charges ledger and review those charges. 

 
5 When you are finished reviewing the ledgers and transactions, close the transaction and ledger 

screens and then click the Home button on the top menu. The Resident screen closes and the 
Community Manager Dashboard screen appears. 

 
 

Reviewing Refund Payables for Past Residents 
 
When deposit accounting results in a refund to the resident, Voyager creates a payable for that refund. 
If your security permissions give you access to payables, you can review the household’s refund pay-
able. We will now review the payable for the household used in our examples. 



 
 

To review a payable 
 
1 From the side menu, select Payables > Review Payable. The Payable filter appears. 
 
2 In the Tenant field, type or select the resident code for the payables to review. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3 Click Submit. The Payable Invoice screen appears. Refund appears in the Invoice # field. The 
Notes field documents the payable as a move-out refund. 

 
Invoice number Notes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4 When you are finished reviewing the payable, click the Home button on the top menu. The Pay-
able screen closes and the Community Manager Dashboard screen appears. 
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Rentable Items and Service Charges 
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Rentable items are items that are rented to residents but are not connected to units—items such as 
garage spaces, carports, and storage lockers. Rentable items can also be rented to non-residents. 
For example, you might rent a parking space to someone who does not live at the property. 

 

Service charges are services that have no physical limit, and so can be offered to an unlimited 
number of residents—services such as cable internet or a pet fee. When you select a service 
charge during the either the leasing or renewal workflows, you can specify the quantity of the 
charge. For example, if there is a pet fee service charge and a future resident has two pets, you can 
add two instances of the service charge to the future resident’s guest card. 

 

This chapter contains the following procedures: 
 
!    Assigning rentable items to residents 

 
!    Releasing rentable items from residents 

 
!    Setting up non-resident lessees and assigning rentable items to them 



 
 
 

Assigning Rentable Items and Service Charges to Residents 
 
 

In this section: 
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Rentable items and service charges are assigned to residents in two ways: 
 
!    For a new resident, you assign rentable items and service charges in the leasing workflow and in 

the move-in procedure. 
 

!    For an existing resident, you assign rentable items and service charges by using a function that 
you can access from the side menu. 

 
Both methods are described on the following pages. 

 
 

Assigning Rentable Items and Service Charges to New Residents 
 

Rentable items and service charges appear in the Rental Options step of the leasing workflow, 
shown below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Reserve 
button 

 
 
 

Quantity (Qty.) field 
 
 

To add a service charge to the lease, type the number of instances of the charge in the Qty. field. 
 

To add a rentable item to a lease, click the Reserve button. The Rentable Item Reservation 
screen appears. 



 
 

Select the Reserve checkbox in the row corresponding to any rentable items that you want to add. 
 
 
 
 
 
 

Reserve check box 
 

Click Save. The screen closes. Voyager calculates the charges and updates the Rentable Items and 
Options spreadsheet. (For complete information about the leasing workflow, see Chapter 2, “Leasing 
Workflow.” ) 

 
 
 
 
 
 
 
 

Rentable items and service charges appear again in the Move-In screen, in the Lease Charges table. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Service charge 
 

 
Rentable items 
 
 
 

The rentable items and service charges selected for the resident (in the leasing step) have a check 
mark in the Select column. You can also add additional rentable items and service charges at this 
time. 



 
 

If you want to select another rentable item, click the button to the right of the Code column. A pop-up 
appears, where you can select a specific rentable item (for example, a specific garage). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select a rentable item, then click OK. For complete information about move-in procedures, see 
Chapter 3, “Resident Handling.” 

 
 

Assigning Rentable Items and Service Charges to Existing Residents 
 

If the resident has already moved in, use the following procedure to add a rentable item or 
service charge to the lease. This procedure can also be used for non-resident lessees. 

 

 
To assign a rentable item to an existing resident 

 

1   From the side menu, select Residents > Rentable Items > Assign Rentable Item. The Assign 
Rentable Item filter appears. 

 
 
 
 
 
 
 
 
 

2   Complete these fields: 
 
 

Property Type a property code or select one from the list. 
 

Type Type a rentable item type or service charge—or select one from the list. 
 

Available Only Select Yes if you want to display only those rentable items that are available. 
Select No if you want all rentable items displayed. 

 

This field does not affect service charges 
 



 
 

3   Click Submit. The Assign Rentable Items spreadsheet for the selected property appears. 
 
 
 
 
 
 
 
 
 

4   In the spreadsheet, locate the specific rentable item you want to assign to a resident (for example, 
Garage 18). If you selected a service charge on the Assign Rentable Item filter, only one row 
appears in the spreadsheet. 

 

5   Click the button to the right of the Lessee field. A pop-up appears. 
 

6   Select the appropriate resident (or non-resident lessee). 
 
 
 
 
 
 
 
 
 
 
 
 

7   Click OK. 
 

8   Complete the following fields: 
 
 

Lease From Type the beginning date of the lease (mmddyy). 
 

Lease To Type the end date of the lease. This field can be left blank if the end date is 
undetermined. 

 
Current Rent Accept the market rent amount associated with the rentable item, or change 

to another amount of your choosing. 
 
 

Note that the Code, Description, and Market Rent fields are read-only. 
 

9   Click Post. The system assigns the rentable item and creates a new lease charge. 
 
 

Releasing Rentable Items 
 

Rentable items are released from residents in two ways: 
 
!    For a departing resident, rentable items are automatically released when the lease ends. 

 
!    For a resident who wants to give up a rentable item before his/her lease ends, you can use a func- 

tion on the side menu to end the lease charge for the rentable item. 
 

This procedure does not apply to service charges. 



 
 

To release a rentable item before the end of lease 
 

1   From the side menu, select Residents > Rentable Items > Release Rentable Item. The 
Release 

Rentable Item filter appears. 
 

 
 
 
 
 
 
 
 
 

2   Complete the following fields: 
 
 

Property Type a property code or select one from the list. 
 

Type Type a rentable item type or select one from the list. 
 

Resident Type a resident code or select one from the list. 
 
 

3   Click Submit.  The Rentable Items spreadsheet for the selected property appears. 
 
 
 
 
 

Release check box 
 
 
 

The spreadsheet contains only the rentable items that have been assigned to residents. 
 

4   Locate the item you want to release and select the Release check box. 
 

5   Click Post. The rentable item is released and the lease charge is terminated. 
 
 

Non-Resident Lessees and Rentable Items 
 
 

In this section: 
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You can add non-resident lessees to the database, allowing you to rent rentable items to people who 
do not live at the property. For example, you could rent a garage space to a non-resident.  Contact 
your Yardi Support Team for help setting up rentable items that can be assigned to a non-resident 
lessee. 

 



 
 
Adding a Non-Resident Lessee 

 
 

To add a non-resident lessee 
 

1   From the side menu, select Residents > Add Non-Resident Lessee. The Non-Resident Lessee fil- 
ter appears. 

 
 
 
 
 
 
 
 
 

2   Select a Property and click Submit. 
 

The Non-Resident Lessee screen appears. (Note: The screen only appears if you have defined at 
least one excluded unit for the property.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3   Complete the following required fields: 
 
 

Unit Select a unit from the drop-down menu. The drop-down menu shows only 
units that are excluded and that are not Model, Down, Admin, or Wait List 
units. 

 
First Name Type the first name of the non-resident lessee. 

 
Last Name Type the last name of the non-resident lessee. 

 
Move In/Out Type the date the lessee will start renting the rentable items. 

 

When the non-resident lessee stops renting items and you perform the Move Out 
function, the 
Move Out date is completed by the system. 



 
 
 

Lease From/To In the Lease From field, type the date the lessee will start renting the rentable items 
(the same date as the Move In date). In the To field, type the date the lessee expects 
to terminate the lease. 

 
 

4   Enter contact information (address, phone numbers, and so on). 
 

5   Click Save. The Resident screen appears; if needed, you can enter additional information. 
 

6   Click Save. The system creates a resident record for the non-resident lessee. 
 
 

Assigning Rentable Items to Non-Resident Lessees 
 

You assign rentable items to non-resident lessees the same way you would assign rentable items to 
existing residents. 

 
Releasing Rentable Items From Non-Resident Lessees 

 
You release rentable items from non-resident lessees the same way you would release rentable items 
from residents. 
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Introduction 

 

 
Make Ready Workflow  

 
When the resident’s status changes to Notice, the unit’s status changes to Not Ready and the 
Pending Make Ready count on the dashboard is increased by one. 

 
When the make ready work is complete, you can update the status of the unit from the 
Community Manager dashboard. 

 
  



 

Performing the Make Ready Workflow  
 
 

To perform the make ready workflow (for properties without make ready details) 
 

1   On the dashboard, click the Pending Make Ready count. The Pending Make Ready table 
appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 

      
 

 
 
 
 
 
 
 
 
 

2   Click the Make Ready button to change the status of the unit to Rent Ready.  A warning 
message appears: Do you wish to make this unit ready? 

 

3   Click OK to continue. 
 

The unit is removed from the table. The Pending Make Ready count is decreased by one. The 
unit’s status changes to Rent Ready.

Pending Make Ready  
 

Pending Make Ready  
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Introduction to Charges 

 
You use Voyager to record charges in groups called batches. This chapter explains how to 
record charges, how to add a one-time charge, and how to reverse a charge.  

 

There are two ways to create batches of charges: detail and quick: 
 

• Use a detail batch to post individual charges. Detail batches comprise charge invoices, which in 
turn comprise multiple charges for an individual payer (resident). 

 

• Use a quick charge to quickly post a charge to a resident’s ledger from. Quick charge can be 
posted directly from the Resident Screen.  

 

Adding a charge to a batch does not update ledgers or financial records. Updating occurs when you 
post a charge batch. You can edit charges until they are posted. 

  



 
 

Creating Detail Charge Batches 
 

If you are creating a batch with only one charge, or with many different charges, you should create 
detail batch. Otherwise, a quick charge batch is usually more efficient. Detail batches comprise 
charge invoices, which in turn comprise multiple charges for an individual payer. 

 

 
To create a detail charge batch 

 

1   Add the amounts of all the charges you will process. Write down the number. 
 

2   Count the charges you will process. Write down the number. 
 

3   On the Community Manager Dashboard, click the New Charge Batch link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Charge Batch link 
 

The Batch Charge screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Declared Type the total dollar amount for charges in the batch.  If amount is unknown, you 
can enter an arbitrary amount (ex: $10,000) and edit once your batch is complete.  

 
Item Declared Type the quantity of charges in the batch. If amount is unknown, you can enter an 
arbitrary amount (ex: 100) and edit once your batch is complete. 
 



 
 

5   Click Save. An empty table appears on the Charge Invoices tab below. 
 
 

New Record button (click to 
add a charge invoice to the 
batch) 

 
 

6   Click the New Record button. The Charge Invoice screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   Complete the top part of the screen: 
 
 

Property Select the property associated with the charges. This helps you filter payers in the 
Charge To field. 

 
Unit Select the unit associated with the charges. This helps you filter payers in the 

Charge To field. 
 

Charge To Select the person who pays the charges. If you completed the Unit field, you can 
only select a person associated with that unit.  *If Charge To person is an 
applicant, future or past resident you will need to click on Charge To hyperlink 
and search for person(s) using the appropriate perimeters.  

 
Total Amount (You cannot edit this field; the value changes as you add charges on the Details 
table below.) 

 
Charge Date Type or select the date on which you want to post the charges. 

 
Post Month Type the month and year in which you want to post the charges. 

 
 

8   On the Details tab, complete a row for each charge that you want to post to the payer’s ledger: 
 
 

Charge Code Select or type the charge code, then press the TAB key to tab to the next field 
(Amount). When you do this, Voyager automatically completes the Description, 
Account, and A/R Account fields with the values associated with the charge code. 

 
Description  (You cannot edit this field; Voyager automatically completes it when you complete 

the Charge Code field. ) 
 

Amount Type the amount of the charge. 
 

Notes Type any notes about the charge, keep in mind these will appear on the 
Resident’s Ledger.  

 



 
 
 

Account  (You cannot edit this field; Voyager automatically completes it when you complete 
the Charge Code field. ) 

 
A/R Account  (You cannot edit this field; Voyager automatically completes it when you 

complete the Charge Code field.  
 

Hold If you want to prevent Voyager from accepting payment for the charge, select this 
check box.  In most cases, this function would be used for a Housing charge.  

 
Another reason you may hold a charge is if the charge or payer is under 
investigation and there might be legal consequences for accepting the payment. 

 
9   Click Save. If there are more charges in the batch, a blank Charge Invoice screen appears. 
 
10 Complete each additional Charge Invoice screen that appears. When the total entered matches 

or exceeds the total declared, or the number of items entered matches the number of items 
declared, the Batch Charge screen appears. 

 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields by clicking the Edit button on the top of the screen, or 
edit each charge invoice by clicking the Edit button in the row corresponding to each invoice 
on the Charge Invoices tab. 

 
11 Click Report.  The Unposted Charge Batch report appears. Verify that the information is 
correct and close the window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

12 On the Batch Charge screen, click Post. 
  

Declared and Entered fields 
should match 



 
13 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays 
confirmation 
 
 
 
 
  
Posting One-Time Charges or Quick Charge 
 
When you post a one-time charge, Voyager adds the charge to the resident’s ledger immediately. The 
charge does not repeat. 
 
To post a one-time charge to a resident’s ledger 
 
1 If not already open, open the resident record that you want to add a one-time charge to.  
 
2 On the Functions menu, click Charge. The Create Charge screen appears. 
 

 
 
3 Complete the screen. 
 
4 Click Submit. 



 

 

Adding Charges to an Existing Batch 
 

You can add charges to any batch until you post the batch. This procedure explains how to add a 
charge using the Detail Batch screen. 

 
You can still add charges to batches that you were added using the Quick Charges screen, as posting 
quick batches creates a detail batch. 

 
 

To add a charge to an existing batch 
 

1   In the Community Manager Dashboard, click the Charges link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Charges 
link 

 
A table of unposted charge batches appears below the dashboard. 

 
 
 
 
 

Batch # link 
 

2   Click the Batch # link for the batch to which you want to add charges. Batches created as 
detail batches and batches created as quick batches appear in the list; you can add charges to 
any batch using this procedure. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 

3   Edit the Total Declared and Items Declared fields to factor in the new charges. For example, if you 
plan to add two $50 charges to a batch with 10 declared charges and a declared total of $500, edit 
the Total Declared field to $600 [($50 × 2) + $600] and the Items Declared field to 12 (10 + 2). 



 
 

4   Click Save. 
 

5   Click Add. The Charge screen appears. 
 
 
 

Click the Batch # link if you 
need to return to the Batch 
Charge screen 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6   Complete the screen. 
 

If you do not complete the Account field, Voyager uses the account associated with the charge 
code. If you do not complete the A/R Account field, Voyager uses the account specified in the 
Receivable field in the Accounts & Options screen. 

 
 

7   Click Save. Each time you click Save, Voyager shows a new Charge screen until the Items Entered 
matches the Items Declared,  or the Total Entered matches or exceeds the Total Declared.  
Then it shows the Batch Charge screen. 

 
 
 
 
 

Updated Declared and 
Entered fields 

 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields or click the Edit button to return to the Charge screen 
and make changes there. Click the Batch # link in the Charge screen any time you need to 
return to the Batch Charge screen. 



 
 

8   Click Report. The Unposted Charge Batch report appears. Verify that the information is correct 
and close the window. 

 
 
 
 
 
 
 
 
 
 
 
 

9   In the Batch Charge screen, click Post. 
 

10 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays confir- 
mation. 

 
 
 
 
 
 

Deleting Charge Invoices from a Batch 
 

You can delete a resident’s charge invoice from a charge batch any time before you post the batch. 
 
 

To delete a charge invoice from a batch 
 

1   From the side menu, select Charges > Edit/Post Detail Batch. The Charge Batch Filter appears. 
 
 
 
 
 
 
 
 
 
 
 

2   Complete the filter, as needed. You can search for both detail batches and quick batches (which 
become detail batches when you post them); you can add delete charges from any batch using 
this procedure. 

 

3   Click Find. Matching batches appear in a table on the Batches tab below. 



 
 

4   Click the Edit button in the row corresponding to the batch from which you want to delete a charge 
invoice. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click Edit 
 

5   In the table on the Charge Invoices tab, click the Edit button in the row corresponding to the 
charge invoice that you want to delete. The Charge Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Click Delete 
 

6   Click Delete. A confirmation request appears: Are you sure you want to delete this item? 
 

7   Click OK. 



 
 

Deleting a Charge Batch 
 

You can delete a charge batch any time before it is posted. 
 
 

To delete a charge batch 
 

1   In the Community Manager Dashboard, click the Charges link. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Charges 
link 

 
A table of unposted charge batches appears below the dashboard. 

 
 
 
 
 

Batch # link 
 

2   Click the Batch # link for the batch you want to delete. Batches created as detail batches and 
batches created as quick batches appear in the list; you can delete any batch using this 
procedure. The Batch Charge screen appears. 

 
 
 
 
 
 
 
 
 
 
 

3   Click Delete. A confirmation request appears: Are you sure you want to delete this batch? 
 

4   Click OK. A confirmation message appears: Your batch has been deleted. 
 

5   Click OK again. 



 

 
Adjust and Post Lease Charges  
 

The Adjust and Post Lease Charges procedure posts adjustments for previously posted charges and 
updates the household's lease charge in a single process. You must make the adjustments for one 
household and one charge code at a time. 

1  To open the Adjust and Post Lease Charge screen from the side menu: Charges > Adjust Lease 
Charges and only the filter section appears. 

 

When you select a resident code on the filter, the household's code is a link to the Resident 
screen. 

The following graphic shows the filter section of the Adjust and Post Lease Charge screen completed 
for a tenant-based subsidy adjustment. In this example, tbs is a tenant-based subsidy charge code and the 
effective date of the adjustments is March 1, 2013. 

 
 

2  Complete the filter section and clicking the Display button shows the lease charge adjustments and 
charges to be posted. 

l  

3  The Lease Charge Adjustments section shows information about the lease charges to be updated. 
The property's accounts-receivable month and the month for which charges were last posted appears 
at the top of this section, followed by old and new lease charges that Voyager will create when you 
post. Adjustments post to the current accounts receivable month of the property. 

l  The New Charges section shows each adjustment that Voyager will create when you post. 

In the following graphic, a user is about to post adjustments and update a household's tenant-
based subsidy lease charges as of March 1, 2013. This household has a $37.00 retroactive 
increase in tenant-based subsidy. The household's lease charges have been posted through 
June, 2013. 

In this example, the Lease Charges Adjustments section contains the following information: 

l  July, 2014 is the accounts receivable month of the property. 

l  
The $125.00 subsidy lease charge began in February 2014. Voyager adds a June 30, 2014 ending date 
for this lease charge. 

 



 

l
  

 

The period between the date that the old subsidy lease charge began and the effective date of 
the new lease charge consists March through June. Voyager will post a $37.00 adjustment for 
each of these four months. 

l  
Voyager creates a new subsidy lease charge of $162.00 beginning on July 1, 2014. This new lease 
charge has no ending date. 

The New Charges section shows the $37.00 adjustments that will post for March through June. 
The adjustments will post to July, the current accounts receivable month of the property. 

 
 

4  Click the Post button.  The charges/adjustments post and updates the household's lease charges as 
of the selected effective date. Adjustments post to the current post month of the property. The post 
month is the month and year that the transaction affects the household's ledger and the general ledger 
of the property. 

 

If needed, you can also export these transactions as a Microsoft Excel or Adobe PDF file. You 
can either open the exported files for review or save them in a directory on your network. 

The Adjust and Post Lease Charges screen remains open after you post the adjustments, so that you can 
adjust another lease charge if needed.  

 

 

 

 

 



 
 

 

In the following graphic, the user is about to post -$37.00 rent charge adjustments for the same period 
to compensate for the $37.00 gain in subsidy. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

 

 

 

The posted lease charges and adjustments appear on the household's ledgers. 

The following graphic shows the resident ledger of the household for which the adjustments were 
posted. The ledger shows four positive charges for tenant-based subsidy and four negative charges for 
rent. 

 
 
 

 



 
 

 

 

 

 

You can open the Resident screen and review the lease charges. 

The following graphic shows the lease charges set up for the household.  

 
  



 
 
 
 

Reversing Charges 
 

You can reverse tenant (resident) charges added by mistake. This procedure creates negative 
charges with zero-dollar receipts to tie the charges and negative charges together. 

 

 
To reverse charges 

 

1   From the side menu, select Charges > Reverse Charge.  The Reverse Charge filter appears. 
 
 
 
 
 

These fields locate the 
charges to be 
reversed. 
 

 
These fields determine how 

the reversal is 
recorded. 

 

 
 
 

2   Complete the filter and click Submit. 
 

Voyager uses entries in the Property through Charge No. fields to locate charges to be reversed. 
Entries in the Post Date through Reverse Notes fields apply to the charges to be reversed in 
the following step. 

 

The Reverse Charge screen appears. 
 
 
 
 
 
 
 
 
 

Select 
charges to 
reverse 

 

 
 

3   Select the charges you want to reverse and click Post. 
 

4   When asked to confirm that you want to post, click OK. Voyager displays confirmation that 
the charges have been reversed. 

  



 

 
Posting Late Fees 
 

Each month on the 5th after entering any rents collected prior to the 4th, run the Post Late Fees 
function within Yardi by completing the following steps: 

 
1   Complete all rent collection and post any un-posted Receipt batch prior to Posting Late Fees.  
Remember any receipt dated after the 5th of the month will be considered late and assessed a late fee.  

2   From the left side menu, click Charges -> Post Late Fee. 

 

 
 
3  Leave the Tenant field  blank.  

4   Fill in your Late Fee Date as the day we want to show the charge (Ex: 2/5/2015) and the Cutoff Date 
as the last day to pay rent before the late fee (Ex: 2/4/2015).  

 

 

 

 

 



 
5  Review the late fee charges before creating a batch by selecting Report Only and click submit, the 
report will generate.   

 
 

6  If this all looks correct, proceed with Posting the Late Fees by returning to the Late Fee filter screen 
(see step 4 above).    

7  Change the Report Only field to Create Batch and click Submit.  This will create a batch, which can 
still be edited and viewed to make sure everything is correct. 

8  To post this batch, choose Charges -> Edit/Post Detail Batch. 

 
 
*  Remember: You will only be able to see batches that you have created, and any other site personnel 
will not have access to the batches you create. Please coordinate with your site personnel in case 
reviewing is needed before posting.  

9  Once you have found your batch, click the Edit button to the far right. Review your charges before 
posting and if everything looks correct, click the Post button and all your late charges will be posted!  
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Introduction to Receiving Payments 
 

When you receive a rent payment, you use Voyager to record the payment and create a receipt. You 
enter receipts in groups called batches. This chapter explains how to record payments you 
receive. It also describes how to process zero-dollar receipts,  how to reapply a receipt and how to 
record an NSF check. 

 
 

Receiving Resident Payments 
 

The Create Detailed Batch function in Voyager creates a batch where you can enter payments for rent, 
charges, and deposits.  

 
 

To receive resident payments 
 

1   Count the payments you have received, to determine the quantity of receipts you will process. Write 
down the number of receipts.  

 
2   Add the amounts of all the payments you will process. Write down the number. 



 
 

3   From the side menu, select Payments > Create Detailed Batch. The Batch Receipt screen 
appears. 
 

 
 

4   Complete the following fields and save: 
 

 
 
 
 

Total Declared Enter total sum of receipts to be entered.  Note, this can be edited before 
posting if needed.  

 
Items Declared Enter number of receipts to be entered.  Note, this can be edited before 

posting if needed. field. 
 

Description This field will auto-populate with the user name, date and time.  Do not edit.  
 

Notes Type note if needed. 
 

Deposit Date In most case this will be the date receipts were entered in Voyager or date deposited into 
bank. 

 
Deposit Memo Enter memo of deposit.  (Example: 12/2014 Rent Payments) 

 
 



 
 

6   To add paym ents ,  click the icon (shown below) under the Receipt Tab.   

 
7   The Receipt window will open.  

 

 
 
Enter the following fields: 
 

 
Property Enter property name.   

 
Unit If the payment is from a current resident, enter the unit number. Once 

selected tab down and the payee will auto-populate.  
 

Payee If the payment is from a past, future, applicant or roommate, you can search for 
them by clicking the Payee Link and applying the appropriate filters.  

 
Total Amount Enter payment Amount 

 
Check Number Enter check, money order, or cashier’s check number.  If entering cash, type Cash into the 

field.  When enter a zero-dollar receipt, type 0$ into the field.  
 

Payment Method Select payment method from dropdown menu.  
 
Date Received Enter date received.  

 
Cash Acct Enter what account payment will be deposited into – Operating or Security.   

 
 



 
 
Notes To Remember When Entering Receipts  

• Verify the correct Cash Acct is selected.  Example Operating or Security.  

 
 

• Make sure the Total Amount matches the distributed.  
• Double check the payment was allocated correctly.  
• Make sure to Save changes.  

 
 

8   In the Notes field enter what charge the payment is being applied towards.  For example: 
“12/2014 Rent” or “10/2014 Late Fee”.  
 

 
  
9   Click Save. 

  



 
 

10  Repeat steps until all of your receipts are entered for this batch. 
 

11 To Post the batch, click the hyperlink from the receipt window Unposted BatchXXXX.  This 
will take you back to the batch window.  Edit the Total Items Declared and Total 
Amount if needed and Save changes. Then click Post, once the batch has been successful 
posted a confirmation message on the top part of the screen.  

 
12.  Print a Deposit slip from Voyager, by clicking Deposit button from the batch screen.  Staple the 
bank receipt and the yellow carbon copy from your bank deposit slip together to be sent in at Month 
End.  
 
 

 



 
 

 
 

Receiving Non-Resident Payments 
 

You must create a detail receipt batch to post payments for non-residents in Voyager. Because 
Voyager does not keep ledgers of non-resident payers, you must manually add each receipt. Each 
receipt can apply to multiple charges. 

 

 
To receive a non-resident payments 

 

1   Count the payments you have received, to determine the quantity of receipts you will process. 
Write down the number. 

 
2   Add the amounts of all the payments you will process. Write down the number. 

 
3   From the side menu, select Payments > Create Detail Batch. The Batch Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Type the total dollar amount for receipts in the batch. 
 

Item Count Type the quantity of receipts in the batch. 
 

Deposit Date Type or select today’s date. 
 
 

5   Click Save. An empty table appears on the Receipt tab below. 
 
 

New Record button (click to 
add a receipt to the batch) 

 
 

6   Click the New Record button. The Receipt screen appears. 
  



 
 
 

7   In the Non-Person Payer field, type the full name of the payer, then press the TAB key. Some fields 
disappear. 

 

 
 

8   Complete the remaining fields on the top part of the screen: 
 
 

Property Select the property associated with the receipts. This helps you filter payers in the 
Charge To 

field. 
 

Total Amount Type the amount of the receipt. 
 

Check Number If the non-resident payer is paying using a check, type the check number in this 
field. 

 
Payment Method Select the appropriate payment method. 

 
Date Received Type or select today’s date. 

 
Post Month Type the month and year in which you want to post the receipt. 

 
Cash Acct. Select the cash account to which you want to post the receipt. 

 
 

9  In the spreadsheet on the Charges tab, complete a row corresponding to each charge to which you 
want to apply the receipt: 

 
 

Pay Type the amount of the charge for which the non-resident payer is paying. The 
receipt pays for the full amount of the charge. 

 
Charge Code Type or select the charge code for the charge. 

 
Account (Leave this field empty; Voyager automatically completes this field based on the 

charge code when you save the receipt.) 
 

The following graphic shows what a completed row should look like: 
 

 
 
 
 
 
 
  



 
 
 

10 Click Save. If there are more receipts in the batch, a blank Receipt screen appears. 
 

11 Complete each additional Receipt screen that appears. When the total entered matches or exceeds 
the total declared, or the number of items entered matches the number of items declared, the 
Batch Receipt screen appears. 

 
 
 
 

Declared and 
Entered fields 
should match 

 
 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can 
modify the amounts in the Declared fields by clicking the Edit button on the top of the screen, or 
edit each receipt by clicking the Edit button in the row corresponding to each receipt on the 
Receipt tab. 

 

12 Click Report. The Unposted Charge Batch report appears. Verify that the information is correct 
and close the window. 

 
 
 
 
 
 
 
 
 
 
 
 

13 On the Batch Receipt screen, click Post. 
 

14 When asked to confirm that you want to post, click OK. Voyager posts the batch and displays 
confirmation. 

 
 
  



 
 

16 Print a Deposit slip from Voyager, by clicking Deposit button from the batch screen.  

 
 
17 Staple the Ticker Tape, bank receipt, the carbon copy from the bank deposit slip to the Deposit 
printed from Voyager to be sent in at Month End.  

 



 

 
Processing Zero Dollar Receipts  

 
It is necessary to process a zero dollar receipt when you wish to apply a credit to a debit in Voyager.   
The Create Detailed Batch function in Voyager creates a batch where you can process Zero Dollar 
Receipts.   

 
 

To create a zero dollar receipt 
 

 
1   From the side menu, select Payments > Create Detailed Batch. The Batch Receipt screen 

appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



 
 
4   Complete the following fields and save: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Total Declared Enter total sum of receipts to be entered.  Note, for Zero Dollar 
Receipts this amount will always be 0.  

 
Items Declared Enter number of receipts to be entered.  Note, this can be edited before 

posting if needed.  
 

Description This field will auto-populate with the user name, date and time. Add your 
Property Name. 

 
Notes Type note if needed. 

 
Deposit Date In most case this will be the date receipts were entered in Voyager or date deposited into 

bank. 
 
 

Deposit Memo Enter memo of deposit.  (Example: Adjustment to Pro-rate Charges) 
 

 



 
 

 
6   C l ick  the icon (shown below) under the Receipt Tab.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   The Receipt window will open.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter the following fields: 
 

 
Property Enter property name.   

 
Unit If the payment is from a current resident, enter the unit number. Once 

selected tab down and the payee will auto-populate.  
 

Payee If the payment is from a past, future, applicant or roommate, you can search for 
them by clicking the Payee Link and applying the appropriate filters.  

 
Total Amount Enter payment Amount ; for Zero Dollar Receipts the total should always be 0.  

 
Check Number When enter a zero-dollar receipt, type 0$ into the field.  

 
Payment Method Select Check. 
 
Date Received Enter date.  

 
Cash Acct Enter what account payment will be deposited into – Operating or Security.   

 
 



 
 

8   In the Notes field enter the purpose for the Zero Dollar Receipt  
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
9   Click Save. 
 
 
 
9   Enter the debt and credited amount in the Charge fields.  The total should always come to $0 

when processing a Zero Dollar Receipt.  
 
10 Click  Save. 
 
11  Repeat steps until all of your receipts are entered for this batch. 

 
12 To Post the batch, click the hyperlink from the receipt window Unposted BatchXXXX.  This 

will take you back to the batch window.  Edit the Total Items Declared and Total 
Amount if needed and Save changes. Then click Post, once the batch has been successful 
posted a confirmation message on the top part of the screen.  

 
 
 



 
 
 

Recording Not Sufficient Funds (NSF) Items 
 

Use the procedure for recording NSF items when a check is returned. This procedure reverses the 
receipt but also creates a journal entry for the bank’s returned check fee and adds your 
organization’s returned check fee charge to the appropriate resident ledger. 

 

 
To record an NSF item for a receipt 
 
1   Use the person search to select the tenant who you wish to adjust and open the Resident Screen, select 
Reports > Ledger. The Ledger will appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Select the receipt you want to re-apply by clicking on the Chg/Rec control number on the right side.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NSF 
button 

 
3   Click the NSF button. 

 
Only receipts that have not been reconciled can be recorded as NSF. The NSF button appears on the 
Receipt screen only if the receipt can be recorded as NSF.   
 
Contact your Property Accountant if you need to record a reconciled receipt as NSF.  



 
 

The NSF Receipt screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Reversal Date Type or select the current date. 
 

Post Month Type the month and year on the general ledger that you want the NSF reversal to 
affect. 

 
Bank Fee Type the bank fee for NSF items, as your organization requires. 

 
Bank Fee Account Select the account to which Voyager posts bank fees, as your organization 

requires. 
 

Payer Fee Type the payer fee for NSF items, as your organization requires. 
 

Payer Fee Chg Code Type or select the charge code for the payer fee, as your organization requires. 
 

Notes Type notes about the reversal, such as the reason.. You cannot leave this field 
empty. 

 
 

5   Click Save. When Voyager asks you to confirm that you want to NSF the receipt, click OK. Voyager 
creates a new receipt with negative amounts for each positive amount on the original receipt. Voy- 
ager references the control numbers of the related receipts in the Notes fields of both the original 
receipt and the NSF receipt. The following graphic shows the Notes field for an original receipt 
that has been recorded as NSF. 

 
 
 

Notes field 
 
 
 

If there was an amount in the Bank Fee field, Voyager creates a journal entry for that amount. If there 
was an amount in the Resident Fee field, Voyager adds the charge to the resident ledger. 



 
 
Re-applying Receipts 

 
The Reapply feature allows you to modify a posted receipt, without changing the deposit record in 
bank reconciliation. You cannot change the amount, but you can apply the receipt to different 
charges or to a different resident.  
 

** Voyager will only allow you to re-apply a receipt that has not been reconciled.  Contact your Property Accountant if 
you need to re-apply a reconciled receipt. 

 

 
To re-apply a receipt 

 

1   Use the person search to select the tenant who you wish to adjust and open the Resident Screen, select 
Reports > Ledger. The Ledger will appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Select the receipt you want to re-apply by clicking on the Chg/Rec control number on the right side.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Re-apply button 
 

3   Click the Re-apply button. A confirmation request appears: 
 

This function will reverse this receipt and require you to enter a new receipt. Are you sure you 
want to reapply this receipt? 



 

 
4   Click OK. A new Receipt screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

5   Edit as needed. 
 

6   Click Save. A confirmation message appears: 
 

Receipt has been successfully re-applied. 
 

7   Click OK. A confirmation request appears: 
 

The web page you are viewing is trying to close the window. Do you want to close this window? 
 

8   Click Yes. 
 

Writing Off Charges 
 
Your Property Accountant will perform Write Off charges in Voyager; the site manager will be asked 
to verify the Collection Report.  

Each month, resident move-out files are reviewed and those with a move-out occurring more than 
30 days prior and have a balance due to the property are reported to the site manager to determine 
whether the amount due will be written-off. 

The Collection Report 

Monthly, the Site Employee Resource Center reviews move-out files with a balance due that is left 
unpaid 30+ days. Not all properties will have collections for the month. The Site Employee Resource 
Center completes the Property Collections Report and emails the report to the site.  

The site manager reviews the amount and accuracy for each resident. The information included in 
the Property Collections Report are the Apartment #, Resident Name, Move-Out Date, Mailed 
Date, Total Due. The site manager then checks “Yes” or “No” to send the account to collections. 

• Any “No” response must be approved by the Property Supervisor. Payments plans are to 
be consistent with Cambridge policy — a maximum of three payment installments with the 
first installment equaling 50% of the debt. 

• If a payment has been made by the resident and the Amount Due is inconsistent with what 
the site manager reports, the site manager should indicate it on the report.  

• Before signing the Property Collections Report, be sure to verify the Amount Due and the 
amount to be written off in Voyager.  

 
 
 



 

 

CHAPTER 19 
 
 
 
 

Processing Housing  
(Tenant-Based Subsidy Receipts) 

 
This section explains how to create and post consolidated receipts for payments from tenant-based 
subsidy providers. 
 
 

In this chapter: 
 

Introduction to Tenant-Based Subsidy Receipts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  207 
Creating Consolidated Receipts for Tenant-Based Subsidy Payments . . . . . . . . . . . …….. . . . . . . . . . . .   209 
Posting Consolidated Receipts for Tenant Based Subsidies . . . . . . . . . . . . . . . . . . . . . . . . . . …… . . . . . .   212 
Reviewing Posted Subsidy Receipts in Resident Ledgers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ……..  214 
 
 

 

Introduction to Tenant-Based Subsidy Receipts  
 
A tenant-based subsidy provider’s payment may consist of one large amount to pay charges for 
many residents. In Voyager, a consolidated receipt distributes the total amount of a subsidy 
payment to pay subsidy charges for each resident in a property. When you create a consolidated 
receipt, Voyager allocates the subsidy payment toward each resident’s subsidy charges. 
 
In this section, you will learn how to complete and post a consolidated receipt for tenant-based 
subsidy payments. 
 

Voyager helps you to quickly complete Voyager screens. For fields that you can complete by typing, typing the first few 
characters automatically displays a selection list based on information that you previously used in that field. You can either 
select from the displayed list or complete the field by continuing to type. 

  



 

 
 
 

 
 
To learn how to record a consolidated receipt for a subsidy overpayment, see “Overpaid Tenant-Based Subsidy Receipts” in Chapter 20. 

 
The following graphic shows the ledger for the resident used in the examples for this section. The 
ledger shows that resident’s rent charges have been paid. The outstanding balance is for the tenant-
based subsidy.  
 

  

Housing Charge 
Balance Due 



 

 
 
Creating Consolidated Receipts for Tenant-Based Subsidy Payments 
 
Creating a consolidated subsidy receipt adds a record for the receipt. You can add or edit the 
information in a consolidated receipt until you create a batch for the receipt. 
 
To create a consolidated receipt for tenant-based subsidy payments 

1   From the side menu, select Payments > Consolidated Receipt > Add Consolidated Receipt 
w/ a Suspense Charge. The Create Consolidated Receipt filter appears. 

 

 
 
The Create Consolidated Receipt filter determines the subsidy charges and adjustments that appear 
on the Consolidated Receipt screen 

 
2   Complete the following fields: 

 
 

Property The property code selected on the Community Manager Dashboard screen appears 
 Type or select the property code, if needed.. 

 
Resident Select a specific resident or leave this field blank to bring up multiple tenants  

 
Charge Code Select Housing charge code – housing. 

 
Subsidy Suspense Select Housing Suspense charge code – hsngsusp 
Charge Code 

 
Hap Month Type the property’s subsidy month and year.  

 
Sort By Select the order in which you want the subsidy charges to appear, by unit or by resident. 

 
 
 
  



 

 

3    Click Submit. The Consolidated Receipt screen appears. 

The Check Amount field in the top part of the screen is for the amount of the payment that you 
received from the subsidy provider. 0.00 initially appears. The Total Details field shows the total 
amount of subsidy charges for the residents listed in the table in the bottom part of the screen. 
The Difference field shows the difference between the payment amount and the total amount of 
the details. 
 
 
 
 
 
 

 

 

  

  

Total amount of housing payment 

Total amount of housing charges 

Difference between check and charges 

Total amount of Housing charges 



 

 
 
 
4    Complete the following fields: 

 
 

Check Amount Enter amount of the provider’s payment. 
 

Description This field will pre-populate with the user/date/time – DO NOT erase.  Do add your 
property name.   

 
Check Number Enter the check number listed on the payment. 

 
Post Date Enter the date the payment was posted or deposited.  DD/MM/YYYY 

 
Post Month Enter the current post month. MM/YYYY  

 
 

 
 

 
 
5    Click Save. In order to post the payment, the difference between the check amount and total 

details must be 0.00 (zero).   You will need to make any necessary corrections prior to posting the 
payment receipt.  

 
6    Once the difference between the check amount and total details is zero, you are ready to post the 

receipt.  
 
7   Click Create Batch, this function will create the batch however you will since need to Post it.  

  



 

 

Posting Consolidated Receipts for Housing (Tenant Based Subsidies) 

When you post a consolidated receipt, you will post the receipt to a batch. You can review and edit 
the transactions in the batch before you post the batch. The transactions will not affect the general 
ledger until you post the batch. 
 
To post a consolidated receipt 
 

1 From the side menu, select Payments > Consolidated Receipt > Review Consolidated 
Receipt. The Consolidated Receipt Review filter appears. 
 
2 Select the consolidated receipt that you created and saved and click Submit. The 
Consolidated Receipt screen appears. 
 
3 Complete the following fields: 

 
Check Number Type the number of the provider’s check 

 
Post Date Type the date that you are posting the receipt. 

 
Post Month Type the month and year that the posted receipt will affect the general ledger. 

 
 
4 Click Save. 
 
 
 

 
 
 
*** Remember you will need to Post or Delete unposted Consolidated Receipt Batches prior 
to opening a new Consolidated Receipt.   
 

5 Review the receipt again to ensure that it is as you expect. 
 
6 Click the Print button in the top part of the Consolidated Receipt screen and print a copy of the 
receipt. 
  

Check and post-date information 



 

 
 
7  When you are ready to post the receipt, click the Create Batch button on the Consolidated 
Receipt screen. The Unposted Receipt Batch report screen appears. The batch number appears in 
the top part of the screen. The batch number is a link to the batch summary. 
 
 
 

 
 

8 Click the batch number. The Batch Receipt summary screen appears. 

 
9  Review the summary information to ensure that it is correct. If needed, you can edit or delete 

transactions in the batch or delete the entire batch. 
 
10  Click the Report button to review the batch report again. 

11  When you are ready to post the batch, click the Post button. A confirmation message appears. 
Click OK. Voyager posts the batch. 

 

 
 

Batch Number 



 

 
Reviewing Posted Subsidy Receipts in Resident Ledgers 
 
You are now ready to review the ledgers of a resident included in the posted consolidated subsidy 
receipt. In this section, we will review the ledger and  Resident ledger of Helen Woods, the first 
resident listed in the details of the posted receipt in our example. 
 
To review the ledger of a resident included in a consolidated receipt 
1 Open the Resident screen for a resident you wish to review.  
 
2 Open the resident’s ledger. The Resident Ledger screen appears. 
 
3 Review that resident’s ledger. In our example, the balance due is now 0.00 (zero). 

 
4 Click on the Chg/Rec number you wish to review.  

6 Click the link to review the charge. The charge is fully paid. 

Link to Housing Receipt  

Charge Status 



 

 

CHAPTER 20 
 
 
 
 

Overpaid Housing 
Or Overpaid Tenant-Based Subsidy Receipts  

 
This section explains how to create and post consolidated receipts for payments from tenant-based 
subsidy providers when the check includes a subsidy overpayment. 
 
 

In this section: 
 
Introduction to Overpaid Tenant-Based Subsidy Receipts . . . . . . … . . .. . . . . . . . . . . .  . ….. . . .  .. . .  215 
Creating Consolidated Receipts for Overpaid Tenant-Based Subsidy Payments. . .. . . . . ... . .. . .. .  216 
Posting Consolidated Receipts for Subsidy Overpayments. . . . . . . . . . . ………….. . . . . . . . . .. . . . .  218 

 

 
Introduction to Overpaid Tenant-Based Subsidy Receipts  
 
Mid-month move-outs, subsidy terminations, or other issues can result in subsidy overpayments. 
Unlike rent that a resident pays before it is due, a subsidy overpayment is not a prepayment. After 
the provider reconciles its records, a subsidy provider will send a payment that is adjusted to 
recover the previously overpaid amount. 
 
When you create a consolidated receipt that includes a subsidy overpayment, Voyager 
automatically creates positive and negative charges posted to your subsidy suspense charge code. 
Voyager holds the negative charge in suspense, to apply the overpayment toward the provider’s 
later subsidy adjustment. 
 

 A subsidy provider may also occasionally underpay. When a subsidy provider underpays, Voyager holds the positive 
charge in suspense to apply to the provider’s later adjustment.. 

 

You can easily track subsidy overpayments. Unused overpaid amounts appear on each receipt until 
you use them to pay later charges. Outstanding amounts and balances appear on ledgers and 
financial statements. 
 
In this section, you will learn how to complete and post a consolidated receipt when a tenant-based 
subsidy provider overpays. You will process consolidated receipts for a subsidy overpayment and 
review a resident’s ledger and HAP ledger. 
  



 

 
Creating Consolidated Receipts for Overpaid Tenant-Based Subsidy 
Payments 
 
After posting monthly charges for a property that includes residents with tenant-based subsidies, you 
receive the provider’s latest subsidy payment. In this example, the subsidy provider overpaid for one of 
the residents. You need to include the overpayment in the consolidated receipt. 
 
To create a consolidated receipt that includes a subsidy overpayment 
1 From the side menu, select Payments > Consolidated Receipt > Add Consolidated Receipt. The 
Create Consolidated Receipt filter appears. 
 
2 Complete the filter, selecting the property, tenant-based subsidy charge code (Housing) , subsidy 
suspense charge code (Housing Suspense), and subsidy month. 
 

 
 
3 Click Submit. The Consolidated Receipt screen appears. 
 

 
 
4 In the Check Amount field in the top part of the screen, type the amount of the subsidy payment. In 
this example, we will record a receipt for a payment of $100.00 more than the amount of the charges. 
Type the number that appears in the Total Details field, plus 100.00.  



 

 
 
 
5 Click Save. The Difference field shows that the payment is for $100.00 more than the amount of the 
total charge details. 
 
You are ready assign the overpayment to the resident for whom it was paid. In our example, we will 
assign the overpayment Jeremy Desmond, the second resident listed in the details. 
 

You could assign the overpayment to any resident in the property. For example, if the overpayment applied to a past resident who had 
recently moved out, you would assign the overpayment to that resident. If the overpayment is split between two residents, you would 
apply the appropriate amount to each resident. 

 
 
 
 

 
 
 
 
  

Amount of provider’s payment 

Difference between payment and charges 

Select  button 



 

 
 
6 On the first empty row in the details table, click the Select button and select the code of the resident 
for whom the overpayment applies.  
 
7 In the Payment field on that row, type the amount of the overpayment. 
 
8 Click Save. The difference between the payment amount and the totals detail is now 0.00 (zero). 
 
 
 
 
 

 
 
9 Print a copy of the receipt using the steps described in the previous lesson. You can use the printed 
copy to compare the receipt to your subsidy voucher. 
 
10 You have created and saved the consolidated receipt.  To Post the batch, click Create Batch and the 
unposted batch screen will appear.  Similar to the last chapter, click on the unposted batch number to 
be directed to the Batch Window where you can review and Post the batch.   

Amount of provider’s payment 

Difference between payment and charges Additional Payment 



 

 

CHAPTER 21 
 
 
 
 

Paying Bills 
 
 

In this chapter: 
 

Introduction to Paying Bills. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .. . .  219 
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Introduction to Paying Bills 
 

You use Voyager to record payable invoices. You enter invoices in batches. Payables in a batch do not 
update vendor ledgers or property financial records until your Property Accountant posts the 
batch.  

 
 

Entering Vendor Invoices 
 
 

To enter vendor invoices in a batch 
 

1   Count the invoices, to determine the quantity of invoices you will process. Write down the number. 
 

2   Add the amounts of all the invoices you will process. Write down the number. 
 

3   In the Community Manager Dashboard,  click the New Payable Batch link. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

New Payable Batch link



 
 

 
The Payable Batch screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4   Complete the following fields: 
 
 

Total Declared Type the total dollar amount for payable invoices in the batch. 
 

Item Declared Type the quantity of payable invoices in the batch. 
 

Description Change the description to “property  week begin – week end” (which should be a Friday 
thru Thursday).  Example:    Stone Creek 01/15 – 01/22.   

 
 
 
 

5   Click Save. An empty table appears on the Payables tab below. 
 
 

New Record button (click to 
add a payable invoice to the 
batch) 

 
 
  



 
 
 
6   Click the New Record button. The Payable Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7   Type or select the payee code in the Payee field and press the TAB key. Voyager displays the 
vendor ’s name and address below the Payee field. 

 

8   Type the complete invoice number in the Invoice # field – for record keeping purposes it is 
important that it is not a partial invoice number.  

 
9   Type the total amount of the invoice in the Total Amount field. 

 
10 Change the dates in the Invoice Date, Post Month, and Due Date fields as appropriate. 
 

 
 



 
 
 

11 If you want to split a payable across multiple properties: 
 

a   On the Details tab, click the Distribute button. 
 
 
 

Distribute button 
 

The Distribute Payable screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 

b   Complete the Distribute Payable screen. 
 

c   Click OK. Voyager adds one line for each property to the payable spreadsheet, splitting the 
amount of the payable evenly between the properties. 

 

13 Complete the spreadsheet on the bottom part of the Payable Invoice screen: 
 
 

Entity Type or select a property code for the first line item. 
 

Amount Type the dollar amount you are paying for the line item. The combined amount of 
all line items must match the amount in the Total Amount field before you can 
save this invoice. 

 
Account Type or select the G/L expense account. 

 
Notes Complete the notes field with a brief memo explaining the payable; example –

Carpet  Replacement #101. 
 
 

14 Click Save. If there are more invoices in the batch, a blank Payable Invoice screen appears. 
  



 
 
 
15 Complete each additional Payable Invoice screen that appears. When the total entered matches or 

exceeds the total declared, or the number of items entered matches the number of items 
declared, the Batch Charge screen appears. 

 
 
 
 

Declared and 
Entered fields 
should match 

 

 
 
 
 
 
 
 
 
 

The Declared and Entered fields must match before you can proceed. If they don’t, you can modify 
the amounts in the Declared fields by clicking the Edit button on the top of the screen, or edit 
each payable invoice by clicking the Edit button in the row corresponding to each invoice on 
the Charge Invoices tab. 

  



 

 
Entering Vendor Invoices as a Credit 

 
 
1   Click the New Record button. The Payable Invoice screen appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2   Type or select the payee code in the Payee field and press the TAB key. Voyager displays the 
vendor’s name and address below the Payee field. 

 

3   Type the complete invoice number in the Invoice # field – for record keeping purposes it is 
important that it is not a partial invoice number.  
 
3   Change the Type to the complete invoice number in the Invoice # field – for record keeping purposes 
it is important that it is not a partial invoice number.  
 
4  Change the dates in the Invoice Date, Post Month, and Due Date fields as appropriate. 

 
5   Type the total amount of the invoice in the Total Amount field.  Often when you have a credit on a vendor 
invoice it appears on the invoice as a negative number, however you will NOT need to enter it as a negative number 
in Voyager.   
 
Instead, adjust the invoice Type to Credit, Voyager will know that the amount is a credit.  For questions regarding 
entering an invoice with a credit in Voyager, please consult with your Property Accountant.  
 
 

 
 
 
 
 

Change Type to Credit 



 
6   Complete the spreadsheet on the bottom part of the Payable Invoice screen: 

 
 

Entity Type or select a property code for the first line item. 
 

Amount Type the dollar amount you are paying for the line item. The combined amount of 
all line items must match the amount in the Total Amount field before you can 
save this invoice. 

 
Account Type or select the G/L expense account. 

 
Notes Complete the notes field with a brief memo explaining the payable; example –

Returned Maintenance Supplies. 
 
 

7   Click Save. If there are more invoices in the batch, a blank Payable Invoice screen appears. 
 
8   Refer to the previous section on completing a Payable Batch.  

 
 

Processing Payable Batches (Every Thursday) 
 

1  Each Thursday after all your weekly payables have been entered.  Keep note of the batch 
number. 

2  From the left side menu go to Reports > Payables > Weekly Payable Report,  select the 
Weekly Payable Report.  

 

 
 

 
 

Property Type or select a property name. 
 

mm/yyyy Type the currect accounting month as mm/yyyy.  Example 05/2015 
 

Batch Type the unposted batch number for your weekly payable batch.  
 
 

3  Click Submit.   
  



 
 

4  The Weekly Payable Report will appear.  Export to PDF by clicking on the PDF button.  
 

5  Print the report.  
 

6  Collect all hard copy paper invoices included in the payable batch; keep in same order they were 
entered.    
 
7  Send the original copies of the invoices and the Printed Weekly Payable report to the Site 
Employee Resource Center each Thursday.  Label the envelope attention to  “Payables” and include 
the dates for which the payables were entered; example – Payables 1/15 – 1/22.  
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Introduction to End of Month 
 

End of Month is when the accounting month is closed and moved into the next month.  It is 
important that all the relevant dates are observed closely on the Operations Calendar and all 
the steps below are complete before the scheduled End of Month.  Once accounting has closed 
the month at your property you will not be able to post to that period,.  
 

End of Month Schedule – Refer to the Operations Calendar on the eExchange 
 
Complete your Month End Checklist by noon of the scheduled day.  Once the checklist has been 
reviewed and your paperwork has been sent to the Corporate Office, accounting will begin the 
process of completing the End of Month functions. Please do not post anything after this date 
until notified by Accounting that Yardi is ready for your next month’s postings.  
 
This process takes a few days, but feel free to reach out to your Property Accountant if you have 
any questions. This will not affect running your Monthly Posting Report. 
 

  



 
 
 

Yardi End of Month Checklist 
!
Community:!________________________________!Month:!__________!Date______________!!
For assistance in completing this checklist, if you are in need of assistance, contact your property accountant.  

!
All!items!must%be!completed!in!the!order!that!they!are!listed.!Before!accounting!
month:end,!complete!the!following!steps:!!
!

YOUR2INITIALS2!

12Print!the!Daily!Activity!report!and!review!the!following!sections:!! !
____________!!

a2Review!and!correct!any!resident!exceptions.2! !
____________!!

b2Review!month:to:month!(MTM)!residents.!Ensure!that!all!MTM!residents!
have!the!correct!MTM!charge.!!

!
!
____________!!

c2Review!on:notice!residents.!Ensure!that!all!move:outs!have!been!
completed!and!that!any!date!changes!have!been!entered.!!

!
!
____________!!

d2Ensure!that!all!move:ins!have!been!completed.!! !
____________!!

e2Ensure!that!all!deposit!accounting!has!been!performed.! !
____________!!

f2Ensure!that!all!lease!renewals!for!the!following!month!have!been!processed!
and!that!any!new!MTM!residents!have!been!converted!to!MTM.!!

!
!
____________!!

g2Ensure!that!all!guest!cards,!traffic,!applications,!and!rental!increases!have!
been!entered.!!

!
!
___________!!

22Enter!all!invoices!for!the!current!month!and!complete!the!weekly!Thursday2
Payable2Processing!(refer!to!page!163).!!

!
____________!!

32Post!all!receipts!applicable!to!the!current!month!for!any!resident.2! !

42Post!all!open!charge!and!receipt!batches!for!the!current!month.!! !
____________!!

62Review!the!following!reports!and!record!the!balances:!!
a2Aged!Receivables!!!

Total!Unpaid!Charges!!
Total!Prepayments!!!!!
!

b2Security!Deposit!Activity22
Current2Dep.Billed22

Current2Receipts22

!
d2Rent!roll2!
e2Daily!Activity22

Number2of2Exceptions2!
2

2

!
!
$_________!
$!_________!
!
$!_________!
!
$!_________!
!
!
!
!
!
22___________!

72Send!all!Bank2Deposit2Reports2(attached!to!corresponding!yellow!copy!of!bank!
deposit!slip!and!bank!receipt)!for!the!current!period!to!Corporate!Office.!!Address!
the!envelope!!“Cambridge%Real%Estates%Services%Attention%–%Yardi%Month%End”.2

!!____________!

 



 

 
Monthly Posting Report 
 
Use the Monthly Posting report to review resident charges prior to the automatic posting that happens 
on the 25th of every month.  The report shows you monthly charges for a specified period. 

To generate the Monthly Posting report: 

1 From the side menu, select Charges > Monthly Posting. The Report screen appears. 

 

2  Complete the filters: 

 
 

Property   Enter the property name. 
 
 

mm/yy  Enter the Month and Year for which the charge will apply, in most cases this will be the 
month after your current account period.   

 
 

Report Only  Select Report Only.   
 

 
Variance?  Select Yes.   
 

 
 

4  Click Submit.  
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